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Trademarks 
Unigraf, UCD, UCD-500, UCD Console and TSI are trademarks of Unigraf Oy. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

USB™, USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum Inc. 

Thunderbolt is a trademark of Intel Corporation or its subsidiaries. 

HDCP is a trademark of Digital Content Protection LLC. 

Windows 11, Windows 10, and Windows 8 are trademarks of Microsoft Corporation. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, under 

normal use and service, for twelve (12) months from the date of purchase from Unigraf or its 

authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or replacement 

of the product. Unigraf shall have the whole discretion whether to repair or replace, and replacement 

product may be new or reconditioned. Replacement product shall be of equivalent or better 

specifications, relative to the defective product, but need not to be identical. Any product or part 

repaired by Unigraf pursuant to this warranty shall have a warranty period of not less than 90 days, 

from the date of such repair, irrespective of any earlier expiration of original warranty period. When 

Unigraf provides replacement, then the defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf will 

provide instructions for returning the defective product. 

CE Mark 
UCD-500 Series products meet the essential health and safety requirements, is in conformity with 

and the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is User Manual of UCD-500 Series, that are USB-connected video interface test units for 

use with a PC with Windows® 11, Windows® 10  or Windows® 8 operating system. 

The purpose of this guide is to 

• Provide an overview of the product and its features. 

• Provide instructions for the user on how to install the software and the drivers. 

• Provide instructions for the user on how to update the FW of the unit. 

• Introduce the HW features of UCD-500 units. 

• Provide instructions for the user on how to use UCD Console software. 

 

Product and Software Version 
This manual explains features found in UCD Console Software Bundle 2.4. Please consult Unigraf for 

differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW and FW 

versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text is formatted 

as follows. Please read these notes carefully. 

Note: This text is an important note 

 

 

Note: This version of the User Manual describes features in UCD Console version 2 based on the 

functionality in Microsoft Windows operating system.  

UCD Console version 2 is available also for macOS operating system to be used in iMac and 

MacBook computers and for Linux operating system. Detailed description of the macOS and Linux 

versions will be added later. 
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 INTRODUCTION 

Product Description 
UCD-500 family are high speed, USB 3.0 connected video interface test units.  

UCD Console is common graphical user interface (GUI) for Unigraf’s UCD-500 series, UCD-400 and 

UCD-300 series units. The outlook and details of UCD Console will vary depending on the capabilities 

of the connected unit and will reflect the features enabled.  

The software package for UCD-500 feature a high-level Software Development Kit (SDK) called Test 

Software Interface (TSI) for use in automated testing. TSI allows for an easy integration of Production 

and R&D testing routines into an automated test system environment. Please refer to TSI 

documentation found in additional Unigraf manuals for more details. 

Product Features 

• UCD-500: DP 2.0 / DP 2.1 capable Reference Sink and Reference Source for verifying DP 

and USB-C connected devices with link rates up to 20 Gbps (UHBR20) using USB-C interface 

and 10 Gbps (UHBR10) using DP interface. 

• UCD-500 Gen2: DP 2.1 capable Reference Sink and Reference Source for verifying DP and 

USB-C connected devices with link rates up to 20 Gbps (UHBR20) 

• High resolution video and audio capture up to 8K @60Hz, 16K @60Hz with DSC 

• Generate HDR formats such as Dolby Vision™, HDR 10 and HDR 10+ 

• 16 GB capture memory 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Available Interface Roles 

UCD-500 products are able to operate in various interface role combinations. The used role is 

selected when UCD Console is launched. 

Selection UCD-500 UCD-500 Gen2 

DisplayPort Sink and Source ● ● 

USB-C DP Alt-Mode Sink and Source ● ● 

DisplayPort Source and USB-C DP Alt-Mode Sink ● ● 

USB-C DP Alt-Mode Source and DisplayPort Sink ● ● 

  



  Introduction 

UCD-5XX Console User Manual v2 8. 

Functional Description 

UCD-500 units consist of a multimedia signal input stage, an internal pattern generator, a control 

stage with on-board frame buffer and a PC interface stage. In the Input Stage the signal is conditioned 

and converted to desired format. The Interface and Control stages are either passing the captured 

data directly to the USB interface or storing it to the frame buffer. The internal pattern generator is 

able to source a signal for testing sink and branch units. The Interface & Control stages are receiving 

instructions from the host PC to configure and control the functionality of the unit. 

UCD-500 Functional Diagram 

Delivery Content 

Please find below an image of the items included in UCD-500 delivery 

1. UCD-500 Unit  

2. AC/DC Power Supply (100 to 240 Vac 50/60Hz input, +12 Vdc output)  

3. DisplayPort cable 0.5 meters length 

4. Micro USB cable for FW update  

5. Passive TBT4 cables, 0.5 and 1.0 meters length 

6. USB 3.0 compliant cable for host PC connection 

UCD-500 

Control & 

Interface 
USB 3.0 

Host PC 

Data 

Multiplexer 

Power 

Delivery 

USB-C 

DP Tx 

Data 

Multiplexer 

Power 

Delivery USB-C 

DP Rx 

DP / DP Alt Mode 

Internal 

Pattern Generator 

On-board 

Frame Grabber 

DP Tx 

DP Rx 
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Connections 

The image below indicates the connections in UCD-500 and UCD-500 Gen2 unit and their 

description. 

 

Name Description 

DP in DisplayPort™ 2.1 capable input (* 

DP out DisplayPort™ 2.1 capable output (* 

USB-C in USB-C PD 3.0 DP Alt-Mode input (20 Gbps) 

USB-C out USB-C PD 3.0 DP Alt-mode output (20 Gbps) 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

USB USB 3.0 connection to the host PC 

JTAG JTAG interface for maintenance purposes 

 

* In UCD-500 10 Gbps link rate maximum, in UCD-500 Gen2 20 Gbps link rate maximum 

Note Capturing and sourcing high resolution video modes and high frame rates set stringent requirements 

on the video cables and connectors. If in doubt, please contact Unigraf Support. 

 

Warning In order to avoid damage to the unit and the PC, please always attach the power cord (Power In) 

to the unit first, and after that connect the USB cable to the PC. 

  

Power 

On/Off 

Power 

In 

USB-C 

In 

USB-C 

Out 

DP In 

DP Out 

USB 

JTAG 
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Safety and Operational Precautions 
Please find below the Safety Precautions for using the Unigraf UCD test instrument. Please also 

carefully read the Notes and Warnings within the text of this manual.  

These Precautions and Warnings are provided to enable a safe use of the UCD test equipment. 

Therefore, Unigraf assumes no liability when the user fails to follow the expressed Precautions and 

Warnings. 

• Use only Unigraf provided AC/DC Power Adapter. Please make sure that connectors and 

cabling to the Power Adapter are intact. In case there are any doubts about the condition of 

the Adapter or cabling, stop using it immediately. 

• It is important to ensure that the used AC input voltage is within the specified range (100 to 

240 Vac 50/60 Hz) and the fuses in the AC lines are of the specified type. If in doubt, do not 

connect the device. 

• When installing the unit, connect the Power Adapter to the UCD device first, after that connect 

the AC plug. Please disconnect the USB cable to the controlling PC and remove cabling to 

DUT while connecting the power input cables. 

• It is forbidden to open the housing of the UCD device without a written permission from 

Unigraf. Failure to comply with this rule will void the warranty of the unit. 

• UCD devices are intended for use as Electrical Test Instrument only. Use for other purposes is 

forbidden. 

• Use UCD equipment only in its specified ambient temperature and humidity.  

• In order to ensure that the UCD device and associated SW will operate properly, please 

ensure that the PC used for controlling the UCD device complies with the minimum 

requirement set by Unigraf. 

• Please keep UCD software updated by regularly checking the updates on Unigraf download 

page (https://www.unigraf.fi/downloads/). Please update the device firmware to match the 

installed software. 
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 INSTALLATION 

Installation Package 
The UCD software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/  

The installation package is a bundle between the components needed for UCD Console and for TSI 

SDK. The bundle contains the following items: 

• Windows drivers (installed during set up)  

• UCD Console software (installed during set up) 

• License Manager (installed during set up) 

• Device configuration utility (installed during set up) 

• DSC compression tools (installed during set up) 

• DSC Content library (optionally installed during set up) 

• Packet Editor (installed during set up) 

• TSI SDK 

• User Manuals including this document. 

In some cases, also the firmware of the unit needs to be updated. If in doubt, please contact Unigraf. 

Note: The software should be installed before connecting the UCD unit to the PC. 

 

Note: System administrator's privileges are required for performing the installation. 

Software Installation 
 Start the installation by running application SoftwareBundle_X.X.XXXX 

Once the installer has started, a welcome page is displayed. The welcome page shows the software 

package release version. 

The user is also asked to confirm 

• Creating a desktop shortcut 

• Installation of Visual C++ redistributable (needs to be present in Windows) 

• Installation of Unigraf USB drivers 

• Installation of DSC Content library 

Note: The size of the DSC Content Library Generator with supporting files is 2.6 Gbytes 

Next dialog confirms the selections made. If you are ready, click Install to start the installation. 

Click Finish to exit the installation dialog. 

Firmware Installation 
Along with the change to UCD Console version 2, Unigraf is restructuring the SW builds and releases. 

For the time being we are releasing FW packages separately from SW for UCD product families. This 

means that SW installation does not automatically install the new FW package. 

After SW installation is completed, please download the FirmwarePackage_X.X.XXXX also available 

on Unigraf download page https://www.unigraf.fi/downloads/ and run the included application. 

New firmware files will automatically be copied to the correct location in the PC. Please follow 

instructions in Firmware Update Procedure below to update firmware in the UCD device. 

https://www.unigraf.fi/downloads/
https://www.unigraf.fi/downloads/
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Firmware Update Procedure 
UCD Configuration Utility is used to load an updated firmware to the device. As an option, UCD 

Configuration Utility can be used to select possible operation roles present in the UCD unit. A firmware 

set for the selected operation roles is created and the firmware set is programmed to the device. 

Please contact Unigraf for details. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC and do not 

power it off before the operation is completed unless specially requested. Avoid plugging and 

unplugging other USB devices when the firmware update is in progress. 

To update the firmware or create a new configuration on a UCD-500 device, please perform the 

following steps: 

 Connect the UCD unit to a power supply and connect the USB cable. 

 Open UCD Console. Select Tools > Firmware Update. 

The first page of the utility indicates the firmware component versions present in the package. Please 

click Next. 

From the list of connected UCD devices please select the one that you want to update. Click Next.  

Updated Modules 

The tool lists the FW components available in the UCD device, the currently programmed FW version, 

and the FW installed in the PC for programming. 

 Click Start to start programming.  

Power Cycle 

When re-initiating the firmware of a UCD device the whole process cannot be done during one 

session. Therefore, on certain point, user needs to power cycle the device (switch off power from 

UCD device > wait for 10 seconds > re-apply power to UCD device). 

 Click OK button on the dialog. 

Note:  The procedure may take several minutes depending on the speed of the USB connection of the host 

PC. 

 

FW currently 

programmed in UCD 

FW available for 

programming FW component 



  Installation 

UCD-5XX Console User Manual v2 13. 

License Manager 

Licensing 

The features of UCD Console GUI are divided into groups based on the target use of the device. Most 

basic features can be used by default, and more advanced feature groups are enabled by dedicated 

licenses. When the licenses are present, the related part of the GUI will be shown, or the related 

control will be enabled. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key enables a 

dedicated function in one device. Each device has its dedicated Seed Number. Each License Key is 

tied to one Seed Number. License Keys can be freely used in any number of PCs 

License keys are managed with UCD License Manager. License manager can be found in the Tools 

menu of UCD Console. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 

When run, License Manager will list the licensing enabled Unigraf devices. In the list of Devices please 

Select the device in question. The serial number and the seed number of your device are printed in 

a sticker attached to the bottom of the device.  

The Rescan… button will re-scan the system for installed hardware. 

Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a unique 

Seed Number. Seed Number of the selected unit can be found in the top of the dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering Licenses. 

Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to the field 

for new licenses. The License Manager will automatically move the caret across the edit boxes during 

typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click the Install. The license is authenticated and if it is valid, 

the license will appear in the list of installed licenses. If the key fails to authenticate, an error message 

is displayed. If this happens, please make sure that the key has been typed correctly and that the 

seed number on the license key sticker matches the seed number displayed in UCD License 

Manager. 
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Please note that to avoid confusion, some letters will never appear in a license key because they 

resemble numbers: For example, capital 'G' and number '6' are very similar when printed with small 

font. When in doubt, use numbers. 

Also, please notice, that characters that cannot be part of valid license key are not accepted as input. 

When appropriate, an automatic conversion is applied while typing: For example, lower case letters 

are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all installed licenses for the selected device. The list shows the name 

of the license and the actual license key characters. 

Import Install licenses from an INI file for the currently selected device. 

Export Save installed licenses for the currently selected device into an INI file for 

backup and distribution to other PCs.  

To export license(s), select the license(s) to be exported and then click the 

Export button. Please note that licenses from multiple devices can be 

exported into the same INI file. 

Remove Selected Uninstall selected licenses. To uninstall a license, click on the license and 

then click the Remove Selected button 
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UCD Console 
UCD Console Version 2 is the 2nd generation graphical user interface (GUI) for UCD family test 

equipment for desktop use. UCD Console provides the user access to all features of the unit. 

UCD Console also includes powerful debugging and analysis tools enabling the user to monitor the 

status of the display interfaces and assist in the problem detection.  

In UCD Console the various features of the UCD unit are divided into interface specific screens and 

tabs. Each tab contains data and controls for a specific feature.  

Note: This version of the User Manual describes features in UCD Console version 2 based on the 

functionality in Microsoft Windows operating system.  

UCD Console version 2 is available also for macOS operating system to be used in iMac and 

MacBook computers and for Linux operating system. Detailed description of the macOS and Linux 

versions will be added later. 

Device Selection 

A shortcut of UCD Console can be found by default under Start Menu.  

Once UCD Console GUI is launched, the dialog provides a list of Unigraf UCD devices connected in 

the PC. Please select the target device by double clicking on the appropriate row. If your device 

cannot be found in the list, please confirm the power and USB connection to the device and click the 

Rescan … button. 

Role Selection 

UCD-500 features two alternative Sink interfaces (DP and USB-C), and in a similar way two alternative 

Source Interfaces. One Sink role and one Source role can be active at one time. Sink / Source role 

selection is done by selecting one of the four combinations during launch of UCD Console. 

Analyzer and Generator Operation 

Most UCD devices can be used with UCD Console as Analyzer (a Sink device) and as Generator (a 

Source device). The functionalities of the two operation modes can be found in separate tabs. This 

User Manual will explain both roles and all role functionalities. 
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Options 
Options can be found in Tools > Options. 

Image File Format 

You can save the captured frames either in PPM, BMP, JPG or PNG bitmap file format. In PPM format 

the files are stored with the captured color depth, with other formats the color depth is truncated to 8 

bits per color. 

Audio File Format 

Audio files are stored in WAV format 

Folders 

Please select the directories in the PC for saving the captured images and audio 

DSC 

DSC temp folder Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related 

configuration files and DSC conversion tools are stored. 

Automatically create missing content When selected, compliance test tool During execution of 

DSC Compliance Tests, the tool automatically creates the 

DSC compressed content used for testing the DUT. 

Keep auto-created By default, the DSC compressed content is deleted after 

use. If selected, the content is not deleted 

Warning: Keeping the automatically created DSC compressed content will shorten the time needed for running 

the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large (appr. 400 GBytes). 

Please make sure that the content will be stored in a medium that has the required space available. 
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Misc. Options 

Apply color conversions to saved 

images: 

When saving captured frames, the Color Mode selected in 

Video tab will be applied also to saved images. 

Bypass 4:2:x –> 4:4:4 conversions: 4:2:2 and 4:2:0 images are previewed and stored as 

received, without pixel doubling. 

Disable firmware version check: UCD Console lets the user operate a non-matching 

Software / Firmware combination. NOT RECOMMENDED. 

DPCD Decoder flags 

Parameters for DPCD decoder in parsing AUX Channel transaction is DPCD Editor and Event Log. 

DETAILED_CAP_INFO_AVAILABLE: Information about DFP capability field in Sink DPCD 

register. 

MAIN_LINK_CHANNEL_CODING_SET Selection of used main link coding 8b/10b or 128b/132b 

Test Date Print Options 

Configure DUT Testing reports. 

Print Date: Include system date and time in the beginning of each 

event line in created reports. 
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Detaching and Cloning Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and controlling 

separate features simultaneously. To detach a tab Right-click on a tab and select Detach Window. 

To glue the tab back to the main window, click on the red Close button in the top right-hand corner 

of the window or press <Alt> + F4 on the keyboard. 

Tabs can also be cloned (duplicated) in order to e.g., monitor various areas of DisplayPort DPCD 

simultaneously without swapping addresses. To clone a tab Right-click on a tab and select Clone 

Tab or Clone and Detach to the two actions simultaneously. 
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 ANALYZER OPERATION 
When used as an Analyzer, the UCD-500 device acts as DisplayPort or USB-C DisplayPort Alt Mode 

Sink or Receiver device. 

Analyzer functionality related controls and dialogs can be used by selecting DP RX tab.  

Please note that in UCD-500, Generator functionality is available simultaneously with Analyzer. Please 

find description of Generator functionality later in this manual.  

Functionality Tabs 

UCD Console features are presented in tabs. Some of the tabs are enabled by default, some only 

when an applicable license is included.  

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to section Appendix B Licensing of this document for description of features and licensing. 

 

Link Tab 
Link tab contains the following panels: Link Status, Link Training Result, Link Capabilities, VCP Table, 

Stream Info and HPD. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between UCD 

Sink and the Upstream Source. It also lists status of other link modes. The data is retrieved from the 

DPCD status registers of the UCD Sink. The status is updated automatically.  

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

FFE Preset: TX Feed Forward Equalization (FFE) preset value (only with 128b/132b channel 

coding) 

Error count: Content of DPCD Error Count registers 

ILA: Status LED for Inter-Lane Alignment 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage 

LT_FAIL Status LED for Link Training failure 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b) 

Framing mode: Currently enabled Framing Mode (Normal or Enhanced) (only with 8b/10b 

channel coding) 

Scrambling: Status of link data scrambling (Enabled or Disabled) 

MST mode: Status of Multi-stream transport (Enabled or Disabled) 

SSC Status: Status of Spread-Spectrum Clock (Enabled or Disabled) 

DSC Status: Status of Display Stream Compression (Enabled or Disabled) 

FEC status: Status of Forward Error Correction function (Enabled or Disabled) 

 

Note: Spread-Spectrum Clock feature will be supported in later versions of UCD-500 
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Link Training Result 

The result of the previous Link Training and values of some key parameters. 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

FFE preset: TX Feed Forward Equalization (FFE) preset value (only with 128b/132b channel 

coding) 

ILA: Status LED for Inter-Lane Alignment 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage 

LT_FAIL Status LED for Link Training failure 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b) 
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Link Capabilities 

Link capabilities allows the user to change the way the Sink capabilities are announced in the DPCD 

capability registers of the UCD Sink.  

Max Lanes: Maximum lane count used 

Max Bitrate, Gbps: Maximum link rate used when 8b/10b link coding is selected in LT. 

DP2.0 Supported Bitrates, Gbps: When selected 128b/132b link coding is supported. 

Link rates used when 128b/132b link coding is selected in LT. 

Please observe the Note below. 

Instead of 10 Gbps, use: For supporting low link rate Source devices, the user can make UCD-

500 sink PHY use a selectable lower link rate when performing “10 

Gbps” link training in protocol level. 

Link rates are: 2.5 Gbps, 2.7 Gbps, 5.0 Gbps and 5.4 Gbps 

Old DP 2.0 LT: When checked LT will follow initial DP 2.0 spec description. 

Otherwise, LT as per DP2.0 SCR LT (DP 2.0 Errata) 

Force cable status to plugged: When checked, sink functionality is active regardless of a failure of 

upstream device detection e.g., due to incorrect AUX Channel 

electrical termination.  

Enable Fast LT: Indicates support for link training without AUX transactions. 

MST: When 8b/10b link coding enabled, indicate support for MST mode and 

Sideband MSG handling. When 128b/132b link coding enabled, 

indicate support for multi-stream transport and Sideband MSG. 

SS SBM: When selected, indicate support Sideband MSG while not supporting 

multi-stream transport. Valid only when “MST” is unchecked. 

FEC (8b/10b): Indicated support for Forward Error Correction feature when 8b/10b 

link coding is enabled 

TPS4, TPS3: Indicate support for Link Training Pattern Sequence 4 and 3 

correspondingly. 

DSC (8b/10b): Select to enable Display Stream Compression (DSC) feature when 

8b/10b link coding is enabled 

Scrambler Reset: Selection of the value to which the Linear Feedback Shift Register 

(LFSR) is reset during scrambler reset 

HPD pulse on Apply: Select to apply a Hot-Plug Detect (HPD) pulse automatically after 

updating the status. HPD pulse duration will be defined in the Pulse 

HPD field in HPD dialog in the bottom of the tab. 

To update the new status to the DPCD registers click Apply. 
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Note:  Please note that deviating from to the rules set in DP 2.1 Specification, UCD-500 allows selection of 

maximum link rate for 8b/10b coding also when support for 128b/132b link coding is enabled. 

 

Note:  When changing link coding capability of the Sink device (8b/10b vs 128b/132b), please make sure to 

issue a Long HPD Pulse after applying new setting or make sure that "HPD pulse on Apply" is selected 

before applying the change 

Stream Info 

Stream Info is achieved from the Main-Stream Attributes (MSA) of the monitored stream. Frame rate 

is measured by UCD Local Sink 

The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate Vertical refresh rate 

HTotal Horizontal total of transmitted main video stream, measured in pixel count. 

HStart Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive Horizontal active, number of active pixels in video line 

HSync HSync width, measured in pixel count. 

VTotal Vertical total of transmitted main video stream, measured in line count. 

VStart Vertical active start from leading edge of VSync, measured in line count. 

VActive Vertical active, number of active lines in video frame 

VSync VSync width, measured in line count. 

CEF Used color mode: Color format + subsampling / colorimetry 

BPC Color depth in bits per color (BPC) 

CRC 16-bit Cyclic redundancy check (CRC) value per color component calculated from 

active pixels 

VFREQ Video Frequency (128b/132b channel coding only) 

DSC CRC 16-bit Cyclic redundancy check (CRC) calculated from compressed pixel stream 

VCP Table 

VCP Table shows allocation of Virtual Channel Payload for active virtual channels. 

The content of VCP Table can be copied by right-clicking on the table and selecting Copy. 

Port#: Port number where the virtual channel is directed. 

SID: Stream identification number of the virtual channel 

Req.PBN: Requested PBN (payload bandwidth number) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot num: Number of VC Payload slots reserved for the virtual channel. 
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HPD 

Cable: LED indicates that the hardware has detected an upstream cable.  

HPD: LED indicates that the HPD signal is Asserted (logical “high”). 

Assert: Click to re-activate the HPD line (set to logical “high”). 

Deassert: Click button to set HPD line to logical “low” (de-asserted) and hence no HPD 

pulse can be generated.  

Pulse HPD: Click to apply an HPD Pulse with programmable duration. Duration will be defined 

in the provided field. 

Short Pulse: Click to apply a short pulse. Pulse duration is 1 ms. 



  Analyzer Operation 

UCD-5XX Console User Manual v2 25. 

HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 

Status 

The status field indicates the HDCP status of the UCD device. 

Active: The link between UCD and the upstream source has been 

encrypted. 

Authenticated: The HDCP handshake between the UCD and the sink unit has been 

completed successfully. 

Declared as HDCP capable: The UCD unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD unit. 

Configuration 

HDCP Capable:  To disable HDCP, uncheck the box. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  

HDCP 1.3 vs. HDCP 2.3 

UCD-500 devices support by default both HDCP 1.3 and HDCP 2.3 standard. 

Note: With current SW release UCD-500 supports HDCP only when 8b/10b link coding is enabled. 
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Video Tab 
 Video tab is the Preview window for the captured video stream. 

Disable / Enable Preview 

Click here the button to start or stop capturing video frames. 

Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected here. 

Video Status 

The details of the captured video are presented below the preview window. 

First row: Counter, frame size, frame rate, color mode, color depth, frame counter. 

Second row: Mvid, Nvid, Horiz Total, Vert Total, Horiz Active, Vert Active, Horiz Start,  

Vert Start, Hor Sync Width, Vert Sync Width. 

Third row: Live preview frame rate. 

Note: Please note that UCD test equipment are able to capture video at full frame rate.  

Live preview frame rate indicates the rate of updating captured video on UCD Console preview 

screen. Live preview frame rate is limited e.g., by the USB communication between UCD test 

equipment and the PC. 
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Color Mode for preview 

 

No Conversion: The captured color components are interpreted as R, G and B 

respectively. No color conversion will be done. 

Auto: The color mode is selected based on the information in the MSA.  

If there is no color information available, “No Conversion” is used. 

YCbCr (ITU-709) - > RGB: The captured data components are interpreted as Y, Cb, and Cr 

respectively. Color conversion to RGB is done based on ITU-709 

standard. 

SMPTE 170M - > RGB: The captured data components are interpreted as Y, U, and V 

respectively. Color conversion to RGB is done based on SMPTE 

170M standard. 

SMPTE ITU-601 - > RGB: The captured data components are interpreted as Y, U, and V 

respectively. Color conversion to RGB is done based on ITU-601 

standard. 

 

Note: Please note that the color mode selection applies to the preview window only. All internal functions 

use the raw image data as captured from the input channel. 

Frame recording 

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered mode can 

also be enabled in this dialog. 

Buffered When checked, all input frames are captured non-drop until the on-

board frame buffer will be full. 

When not checked, only one input frame is buffered at a time. Frames 

will be skipped if the transfer of the data to the PC is slower than the 

input data rate. 

Capacity of the buffer Capacity of the on board frame buffer with the selected video mode. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 

Full Screen 

Preview captured video full screen, scaled to vertically fit the screen. 

Double-click on the screen to exit full screen mode. 
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Snap Frame 

 

 When clicked, one frame of the incoming video is captured and shown in a new tab. Each click 

captures a new frame and opens a new tab. 

Color Information of the captured frame can be evaluated by placing the mouse cursor on top of the 

preview image.  

Info field in the lower right side of the bottom panel lists: 

• Location of the cross cursor on the bitmap stating from the upper left corner 

• The intensity of the RGB and YCbCr components of the pixel on the cursor location in 

hexadecimal values 

Zoom  

Zoom level of the captured frame can be altered by right clicking on top of the preview image and 

selecting between 

• Fit Window 

• Zoom 25%, 50%, 100%, 200%, and 500% 

Save Frame 

The captured frame current tab can be saved to a bitmap file in the PC by right clicking on top of the 

preview image and selecting Save as…. The format and storage location can be selected in the 

opening dialog. The available bitmap formats are BMP, JPG, PNG, and PPM.  

Note: In PPM format the files are stored with the captured color depth, with other formats the color depth 

is truncated to 8 bits per color. 

The selections in Tools > Options menu define if the frame bitmap will be stored as captured from the 

display interface or if the color mode conversion selected for preview will be applied. 
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Preview DSC Decompressed Stream 

In order to capture and preview DSC compressed video DSC must be enabled in Link Capabilities 

dialog in Link tab. 

Select Enable Preview to verify that DSC compressed stream is received. 

Click Snap button to capture one frame and start the decompressor (offline in the PC). Once the 

decompression is ready, the frame is shown, and Log lists the details of the compressed image 
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Buffered Capture (video, audio) 

Capture of video, audio, and metadata in a file for later analysis. Video can be stored as RGB or RAW 

data.  

Data Chart indicates the approximate order of captured items with colored stripes (blue: video frames, 

green: events, red: audio data. 

Amount of frames: Number of video frames captured. 

Events: Please refer to chapter Event Log for details of the captured events 

Open storage folder: Data save folder is defined in menu Tools > Options. Captured video, 

audio and data is saved in a subfolder of this folder. The name of the 

subfolder is “buffered_capture_yyyymmdd_hhmmss” (e.g., 

buffered_capture_20210301_130532). 

 

Note: Video Preview needs to be disabled to use Data Capture functionality. 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and recording. 

Up to eight channels will be shown based on the received audio stream. 

The audio signal format is shown in three ways 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum 

display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum display 

can be selected between ‘Linear’ to 100 dB. 

Enable Preview / Disable Preview 

This button controls capturing the audio data. 

Select Monitored Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected from Current Stream 

selection in the bottom of the dialog. 

Note: Please note that if the captured audio signal is constant, and audio signal frequency and audio 

sampling rate (e.g. 1000 Hz audio and 32 KHz sampling) match audio preview sampling rate, the 

‘oscilloscope’ panel will seem static. Signal capture can be verified by ensuring that Frame # below 

the panels is increasing. 
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Playback device selection 

The captured audio can be played back in the PC. The combo-box defines the audio device in the 

host PC through which the captured audio is played. By default, No audio playback is selected. 

Note: Please note that the audio capabilities of the audio playback device of the PC are not automatically 

reflected in the audio capabilities description in UCD-500 EDID. Since UCD-500 is not performing 

any audio format conversion, it might occur that the source provides an audio format that the selected 

playback device is not supporting. In case a conflict occurs, please change manually the EDID content 

or disable audio playback to monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC configuration. 

Audio Buffer Size 

The amount of buffering used in the data transfer between the UCD-500 unit and the PC in Audio 

buffer size in Tools > Options dialog, Main buffer. Increased buffer size will ensure a smooth audio 

output but will also increase the delay between the capture of the audio stream and its playback. 

Start audio recording 

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV (*.wav) 

format. Recording duration is defined in milliseconds (ms). The folder where the audio file will be 

saved can be selected in Tools > Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream and the 

number of audio packets captured. 
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EDID Tab 
EDID Tab provides tools for accessing the EDID and Display ID of the UCD Sink presented to the 

Upstream Source Device. There are three basic functions: 

• Load and save EDID data files in the host PC 

• Edit the EDID contents either in EDID Editor or in hex format 

• Program and read the contents of the EDID memory for all virtual channels 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please note that 

the program does not alter the contents of the EDID file or verify its integrity during load and save 

operation. 

Note: Four blocks (512 bytes) of EDID code are read. If the device is not supporting all four blocks, the non-

supported area is replaced with blanks. 

 

Note: All virtual ports have their individual EDID – Display ID content. Currently only EDID of  

virtual port 0 can be accessed 

EDID Editor 

Please see the description of the EDID editor in Chapter EDID Editor later in this document. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the UCD Sink. 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

DPCD Decoder flags in Tools > Options contain control of DETAILED_CAP_INFO_AVAILABLE flag 

and MAIN_LINK_CHANNEL_CODING_SET flag. 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes Write the portion of data shown in the window in question to the DPCD registers. 

Set Reference Store currently shown data as a reference for comparison 

 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 

Saving and Loading DPCD Content 

DPCD data in the selected address areas can be saved as a file in your PC. There are two alternative 

formats listed below. Please add the intended format when saving: 

• Binary DPCD Fata File format (*.DPD). This is Unigraf proprietary format. You can also load 

the DPCD content stored in this format. 

• HEX Dump (*.HEX) in a human readable text format. 

Click Save to select the location and the format of the file.  

Click Load to load DPCD data saved in DPCD Data File (*.DPD) format to the editor.  

To program the data into the DPCD registers of UCD Local Sink click Write Changes. 

Note: - User control like Link Training or mode changes will modify the content of the DPCD registers 

- During a reboot of UCD-500 the DPCD registers will be returned to their default values 
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SDP Tab 
In SDP Tab shows the Secondary-Data Packets sent by the Source device. Click Refresh to re-read 

the data. 

The following packets are recognized: 

• Audio_TimeStamp 

• Audio_Stream 

• Extension 

• Audio_CopyManagement 

• ISRC (International Standard Recording Code) 

• Video Stream Configuration (VSC) 

• Camera Generic 0 

• Camera Generic 1 

• Camera Generic 2 

• Camera Generic 3 

• Camera Generic 4 

• Camera Generic 5 

• Camera Generic 6 

• Camera Generic 7 

• Vendor-Specific Infoframe packet 

• AVI InfoFrame packet 

• Source Product Descriptor InfoFrame packet 

• Audio InfoFrame packet 

• MPEG Source InfoFrame packet 

• Dynamic Range and Mastering InfoFrame 

• Picture Parameter Set (PPS) 

Saving SDP Packets 

Packets can be saved in a file in binary format. Click Save and in the dialog select the packet types 

of choise. File name will be of format ATS_2022-07-28T15_54_24.bin, where ATS is the packet type 

and 2022-07-28T15_54_24 the time stamp.  

Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document 
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DSC Tab 
DSC tab contains status of the Display Stream Compression (DSC) feature, and definition of DSC 

support capabilities that UCD-500 defines in its DPCD register. 

Enabling DSC 

Enabling DSC feature is controlled by the connected source device. When connected, a source 

verifies corresponding registers in DPCD of UCD-500 sink to find out if DSC capability is declared.  

DSC Capable UCD-500 is declared as DSC capable. Control is only in use with 8b/10b link 

coding. 

DSC Enabled Connected source has enabled DSC 

DSC Support Capabilities 

The various controls in this tab change the content of UCD-500 sink DPCD register address range 

(0x00061 through 0x0006F) related to DSC. Please click Apply to enable the change. 

Apply: Write changes to UCD-500 sink DPCD registers 

Refresh: Re-read the content of UCD-500 sink DPCD and update the control status. 

Reset: Reset the content of UCD-500 DSC related DPCD registers (0x00060 

through 0x0006F) to the default values as defined in UCD-500 firmware. 
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FEC Tab 
FEC tab contains control of the FEC (Forward Error Correction) feature, Error Detection table and 

FEC Status Log. 

Enabling FEC 

Enabling FEC feature is controlled by the source device. When connected, Source verifies 

corresponding registers in Sink DPCD to find out if sink is FEC capable.  

FEC Capable: UCD-500 is declared as FEC capable. Control is only in use with 

8b/10b link coding. 

Generate HPD on change: When selected, UCD-500 generates a HPD to establish a new 

connection after the change to make sure that the Source re-reads 

the FEC capability status 

FEC Enabled: LED to indicate if the source has enabled FEC 

 

Update: Read FEC Error Counters from DPCD 

Clear Counters: Clear FEC Error Counters in DPCD. 

 

FEC Status Log lists FEC events. 
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Source DUT Testing Tab 
Please refer to Appendix E later in this document for description of the tests available. 

Select the tests for execution by clicking the corresponding row. 

Run Selected: Click to start selected tests. By clicking Abort the sequence is stopped. 

Select all: Select all tests in the selected tab. 

Invert selection: Invert selection of tests selected. Hint: To clear all selections, click Select all 

and then Invert selection. 

Configure: Clicking opens a dialog for defining the test parameters for the selected test 

set. Please refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python 

applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail  

Repeats: Repeat the selected test several times 

Delay time: Delay in seconds between individual tests. 

At the completion of each test the result of the test is indicated in the matrix on the right hand side of 

the test panel. For each test the matrix lists the number of occurrences of each result and the number 

of tries performed. 

Save Report: Click to generate a report file in HTML format for sharing the results with other 

parties for viewing without UCD Console. 

Clear All: Clear the test log and the results matrix 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in Appendix E 

of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console or with TSI 

scripting or sharing. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console or with 

Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… to 

save or recall a configuration.  
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USB-C Monitoring 

In UCD-500 with USB-C DP Alt-Mode Sink or Source in selected device role, the following interface 

specific tabs are available. 

• USB-C Power Delivery (PDC) 

In USB-C Power Delivery tab (PDC) operator can evaluate the status of the USB-C connection and 

USB Power Delivery Contract, the various roles adopted, and the configuration of the DP Alternate 

Mode. The user can set the initial roles for the UCD-500 test equipment and the optional capabilities 

for UCD-500 in the USB-C PD Contract. Controls allow user also to swap Power and Data roles.  

USB-C Monitoring dialog is divided into four panels. The upper left panel is a Status List indicating 

statuses of both port partners, UCD-500 and the connected DUT. 

The tabs on the right panel configuration dialogs of various USB-C interface functions. 

The bottom panel indicates status of the cable connection and PD Control controls for role swaps 
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Status List 
In Status List the information is presented in foldable sections. Each section contains information 

related to one feature of USB-C interface or PD protocol. The user can fold out the sections needed 

for the task in question.  

Status: UCD-500 internal status (Data role, Power Role, VConn status) 

DUT Status: Status of the connected USB-C port partner gained from status messages 

(Data role, Power Role, VConn status) 

PD Contract: Details of the PD Contract (Power Source: PDO Type, PDO Voltage, PDO 

max current; Power Sink: RDO max current, RDO operating current, USB 

statuses) 

 

Bus Electrical Status: Vbus voltage and current, CCI and CC2 voltage, VCONN voltage and 

current) 

DUT Discovery: Status of the connected USB-C port partner gained from discovery 

messages (Data Capabilities, Product Type, Vendor and Product ID, 

device version number, supported SVIDs) 
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DP Alt Mode support: Supported DisplayPort Alt Mode features (Supports DP v 1.3,  

Supports USB gen2, Pin Assignments supported as DFP_D and 

UFP_D) 

UCD-XXX DP Alt Mode Status: UCD-500 internal DP Alternate mode status (DP Alt Mode Status, 

Multi-function preferred, HPD status, Select DP v1.3, Select USB 

gen2, Pin Assignment selected) 

DUT Alt Mode Status: Status of the connected USB-C port partner gained from status 

update messages (DP Alt Mode Status, Multi-function preferred, 

HPD State, Power low) 
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Capabilities 

Initial Role: Defines the role which UCD-500 presents itself in the start of PD 

communication (both power and data role). 

Reject Swaps: Allow or reject role swap requests from the connected port partner. 

CC Pull-up: Control of Rp that Source uses to advertise the current source capability 

in initial USB Type-C operation and in PD Rev 2.0 operation. 

Try Behavior: Control the USB-C PD role that UCD-500 initially takes in the connection 

handshake. 

UCD-500 Status: Status information provided by UCD-500. 

Accessories 

Audio Accessory: Enable simulation of Audio Accessory support 

Debug Accessory: Enable simulation of Debug Accessory support 

 

Enabling Audio Accessory and Debug Accessory extends USB Type-C Connection State Machine 

with *.Accessory states. (Please refer to USB Type-C specification for details). 

Note: Please note that UCD-500 does not support any physical connections for the Accessory functions. 

The selections enable only behavioral simulation. 
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DP Alt Mode 
Controls and capability settings for DisplayPort Alternate Mode. 

Enter 2 lane mode (D): Restart mode discovery and advertise support for mode 

D  

(2 DP lanes + USB SS). 

Enter 2 lane mode (C,E): Restart mode discovery and advertise support for modes 

C and D (4 DP lanes). 

Exit DP Alt Mode: Exit DP Alternate mode. 

Disable DP Alt Mode: Exit DP Alternate mode and advertise no DP Alternate 

mode support. 

Auto enter on connect: Start mode discovery after connection and enter DP 

Alternate mode if suitable configuration is found. 

Multi-function preferred: When entering DP Alternate Mode, select mode D. 

 

DP to Type-C Cable Adapter 

USB-C to DP Bi-directional Cable contains an active converter microchip that needs to be 

powered from USB-C interface. Therefore UCD-500 must be initially configured in power 

source role for USB Default Operation where it applies vSafe5V on Vbus to power up the 

microchip in the cable. 

DP Alt Mode Capabilities 

Supported Pin Assignments declared in DisplayPort Capabilities discover message. Separate for 

UFP_D (DisplayPort sink) and DFP_D (DisplayPort source) 
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Power Source 
Definition of Power Data Objects (PDO) for UCD-500 when acting as Power Source Port. 

PDO Type: Definition of power source type (Disabled, Fixed, Variable or Battery) 

Note: The requirement is that Sources shall supply at least one fixed supply capable of supplying vSafe5V 

 

Note: Please note that UCD-500 is not able to simulate as Source the electrical behavior of Variable and 

Battery source types. 

Refresh Re-read status from UCD-500 

Apply Program new values to UCD-500 

Load PDO Load a stored Power Source PDO configuration from file. 

Send PDO Send a Source Capabilities message 

Save PDO Store current Power Source PDO configuration to a file 
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Power Sink 
Definition of Power Data Objects (PDO) for UCD-500 when acting as Power Sink Port. 

PDO Type: Definition of power source type (Disabled, Fixed, Variable or Battery) 

Note: The requirement is that Sources shall supply at least one fixed supply capable of supplying vSafe5V 

 

PDO type priority Setting of the policy used for automatic selection from available PDOs 

advertised by Source Device. (Prefer higher current / Prefer higher voltage / 

Prefer higher power) 

Refresh Re-read status from UCD-500 

Apply Program new values to UCD-500 

Load PDO Load a stored Power Source PDO configuration from file. 

Save PDO Store current Power Source PDO configuration to a file 
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Cable Info 
Cable Info tab displays the information received from the cable as a response to Discover Identity 

command sent to SOP’. 

Note: Please note that cable info can only be read when in DFP Data Role. 
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Controls 
Control tab includes miscellaneous controls related to UCD-500 behavior as a USB-C PD Port 

Partner. 

PD Contract Settings 

Automatically negotiate power contract: When selected UCD-500 will start power contract negotiation 

if suitable configuration is found.  

RDO Flags 

Give back flag: When selected, UCD-500 sets GiveBack flag in its Request Data Object 

No USB suspend: When selected, UCD-500 sets No USB Suspend flag in its Request Data Object 

USB Communication Capable 

You can control the USB Communication Capable bit in its Request Data Object. 

Note: Please click Apply to enable changes. 
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Bottom Panel 
Bottom panel includes statuses and controls for the USB-C connection 

Status 

PDC Status Status of USB-C PD Controller 

DUT Attached: Indication that Attach is detected by the Source port in one of its CC lines. 

Type of USB-C cable detected. 

Attach / Detach: Manually Attach or Detach USB-C port partners. 

Reconnect: Restart USB-C Source-to-Sink attach procedure. 

Cable Orientation: Cable orientation status: Straight or Flipped. 

Note: Please note that UCD-500 is not automaticelly Attached to the connected port partner even if the 

cable is connected physically. The user needs to to click the Attach button manually to make the 

connection. 

PD Control 

Send PR_SWAP: Send PR_Swap message to request an exchange of power roles. 

Send DR_SWAP: Send DR_Swap message to request an exchange DFP and UFP operation 

between Port Partners while maintaining the direction of power flow over 

Vbus. 

Send VCONN_SWAP: Send VCONN_Swap message to request an exchange of Vconn Source. 
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 GENERATOR OPERATION 
When used as a Generator, the UCD device acts as DisplayPort or USB-C DisplayPort Alt Mode 

Source or Transmitter device. Generator functionality related controls and dialogs can be used by 

selecting DP TX tab.  

Please note that in most UCD-500 Series units Analyzer functionality is available simultaneously with 

Generator functionality. Please find description of Analyzer functionality earlier in this manual.  

Functionality Tabs 

UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing 

Link Tab 
Link tab shows the status and control items for the DisplayPort link. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between the 

connected Sink and UCD Source. It also lists status of other link modes. The data is retrieved from 

the DPCD status registers of the connected Sink. The status is updated automatically, but in case it 

seems that the update is delayed, please click on Force update button. 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization 

VS/PE (level): Voltage Swing / Pre-emphasis level 

FFE preset: TX Feed Forward Equalization (FFE) preset value  

(only with 128b/132b channel coding) 

Error count: Content of DPCD Error Count registers 

ILA: Status LED for Inter-Lane Alignment 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage 

LT_FAIL Status LED for Link Training failure 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b) 

Framing mode: Status of Enhanced Framing symbol sequence (only with 8b/10b) 

Scrambling: Status of link Data Scrambling (Enabled or Disabled) 

MST mode: Status of the Multistreaming (MST) mode 

SSC status: Status of Spread-Spectrum Clock (SSC) function 

DSC Status: Status of Display Stream Compression (DSC) function 

FEC status: Status of Forward Error Correction (FEC) function. 

LTTPR Status: Status of Link Training-tunable PHY Repeater (LTTPR) function 

 

Send ACT: Force sending an Allocation Change Trigger (ACT) sequence over the Main-Link  

Force update: Re-read statuses to update the panel 

Note: Spread-Spectrum Clock feature will be supported in later versions of UCD-500 
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Link Configuration 

Set target capabilities for the link training. Click Link Training to with changed features.  

DP1.4 Number of Lanes Lane count used when 8b/10b link coding is selected in LT 

DP1.4 Bitrate, Gbps Link rate used when 8b/10b link coding is selected in LT 

DP2.0 Number of Lanes Lane count used when 128b/132b link coding is selected in LT 

DP2.0 Bitrate, Gbps Link rate used when 128b/132b link coding is selected in LT 

Force DP 2.0 UCD-500 Source uses only 128b/132b link layer protocol, no fall back to 

8b/10b link layer. 

Try DP 2.0 UCD-500 Source checks capabilities of the connected Sink and, if it 

supports 128b/132b link layer protocol, it starts Link Training with 

128b/132b link layer. If LT fails it falls back to 8b/10b link layer protocol 

Old DP 2.0 LT When checked LT will follow initial DP 2.0 spec description. Otherwise, LT 

as per DP2.0 SCR LT (DP 2.0 Errata) 

LTTPR Select to enable Link Training Tunable PHY Repeater (LTTPR) protocol 

support 

FEC (8b/10b) Enable Forward Error Correction feature (only in 8b/10b coding) 

Enhanced Framing Mode Enable Enhanced Framing Mode 

Instead of 10 Gbps, use: For supporting low link rate Sink devices, the user can make UCD-500 

source PHY to use a selectable lower link rate when performing ‘10 Gbps’ 

link training in protocol level. 

Link rates are: 2.5 Gbps, 2.7 Gbps, 5.0 Gbps and 5.4 Gbps 

Enable SSC Enable down spreading of link frequency (SSC). 

Amp (‰) SSC Spreading Amplitude. Allowed amplitude range is 1 to 10‰ (per mil, 

0.1%) (It is mandatory for a DP Rx to support up to 0.5% down spread). 

Freq (Hz) SSC Modulation frequency.  

Allowed Frequency range is 30 to 35 kHz.  

Scrambler Reset: Selection of the value to which the Linear Feedback Shift Register (LFSR) 

is reset during scrambler reset. 

In Auto mode UCD verifies that connected DP Sink supports eDP and 

Alternate Scrambler Seed, and then applies FFFEh. If not, FFFFh will be 

used. 

Note: Spread-Spectrum Clock feature will be supported in later versions of UCD-500 
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Link Overrides 

Voltage Swing (level): Override Voltage Swing level selected during link training 

Pre-emphasis (level): Override Pre-emphasis levels selected during link training 

FFE pre-sets: TX Feed Forward Equalization (FFE) preset value (only with 

128b/132b channel coding) 

Apply to validate changes. VS/PPE or FFE overrides are applied immediately to DPTX transceiver 

when 'Apply' is clicked. Please note, that It affects main link signal amplitude and pulse shape only. 

No AUX exchange takes place. The change can be checked only with a scope. Overrides are 

removed at the beginning of the next link training. 

Link Pattern 

Select between Active video and audio, Idle pattern, or special bit patterns. 

Except for Active Video and Idle Pattern, Link Training will NOT be initiated on such events as cable 

re-plug, Long HPD pulse and IRQ_HPD pulse due to link loss. 

Active Video Transmit Video Pattern, Audio and Metadata 

Idle Pattern Link is active but no stream data is being transmitted 

Training Pattern 1 Send Link Training Pattern Sequence 1 (TPS1) 

Training Pattern 2 Send Link Training Pattern Sequence 2 (TPS2) 

Training Pattern 3 Send Link Training Pattern Sequence 3 (TPS3) 

Training Pattern 4 Send Link Training Pattern Sequence 4 (TPS4) 

PRBS7 Send PRBS7 Link Quality Test Pattern 

HBR2 Compliance EYE pattern Send HBR2 Compliance EYE pattern 

SER (Symbol Error Rate) Send Symbol Error Rate Measurement pattern 

Force Video Reference Source will continue Video pattern transmission on 

the previously established link configuration regardless of the 

link status. 

Force Idle Reference Source will continue Idle pattern transmission on 

the previously established link configuration regardless of the 

link status.  

PRBS9 Send PRBS9 Link Quality Test Pattern 

PRBS11 Send PRBS11 Link Quality Test Pattern 

PRBS15 Send PRBS17 Link Quality Test Pattern 

PRBS23 Send PRBS23 Link Quality Test Pattern 

PRBS31 Send PRBS31 Link Quality Test Pattern 

Link square pattern Send Square Sequence Pattern. 

The number of continuous 1s followed by continuous 0s is 

given as a parameter. 0x00 represents one set of 1s and 0s, 

0xFF represents 256 1s and 0s. 

Click Apply to validate the selection. 

Note: Please note that except for Active Video and Idle Pattern, Link Training will NOT be initiated on such 

events as cable re-plug, Long HPD pulse and IRQ_HPD pulse due to link loss. 

 After using the special bit patterns, in order to return to the default operation mode, please select 

Active Video and click Apply. 
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Stream Info 

Stream Info is achieved from the Main-Stream Attributes (MSA) of the monitored stream. Frame rate 

is measured by UCD Local Sink 

The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate Vertical refresh rate 

HTotal Horizontal total of transmitted main video stream, measured in pixel count. 

HStart Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive Horizontal active, number of active pixels in video line 

HSync HSync width, measured in pixel count. 

VTotal Vertical total of transmitted main video stream, measured in line count. 

VStart Vertical active start from leading edge of VSync, measured in line count. 

VActive Vertical active, number of active lines in video frame 

VSync VSync width, measured in line count. 

CEF Used color mode: Color format + subsampling / colorimetry 

BPC Color depth in bits per color (BPC) 

CRC 16-bit Cyclic redundancy check (CRC) value per color component calculated from 

active pixels 

VFREQ Video Frequency (128b/132b channel coding only) 

DSC CRC 16-bit Cyclic redundancy check (CRC) calculated from compressed pixel stream 

VCP Table 

VCP table shows allocation of Virtual Channel Payload for active virtual channels. 

The content of VCP Table can be copied by right-clicking on the table and selecting Copy. 

Port#: Port number where the virtual channel is directed. 

SID: Stream identification number of the virtual channel 

Req.PBN: Requested PBN (payload bandwidth number) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot num: Number of VC Payload slots reserved for the virtual channel. 
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Pattern Generator Tab 

MST: When 8b/10b link coding enabled, enable MST mode. 

When 128b/132b link coding enabled, enable multi-stream transport. 

Number of streams: When MST mode or multi-stream transport enabled, select number of 

streams 

Note: Please note that the actual number of streams sent will be negotiated between the source and the 

sink during link training. 

 The video modes that can be used in MST streams are limited by the overall capability of the 

DisplayPort link and the capability of the connected DisplayPort Sink or Branch device.  

Use timings from EDID: UCD reads the EDID of the connected Sink and lists only timings that 

are featured there. 

Manage Timings: Please see chapter Manage Timings later in this manual 

Info: Used link payload / Total link capability in Gbps 

Auto-Apply: In order to avoid sourcing invalid video mode combinations, new 

settings are being validated when the user is clicking Apply. 

Automatic validation will be applied when Auto-Apply is checked. 

Apply: Apply recent changes 
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Pattern 

Configuration of the video sent in the corresponding stream  

(Controls vary between selected pattern type) 

Predefined Timings 

The list includes a set of common fixed video timings. Please find a list of the timings with their major 

details in Appendix C of this document. With Manage Timings function the user can add timings in 

the list and select which timings are shown in the selection. 

Color Depth 

Available color depths are: 6, 8, 10, 12 and 16 bpc. Color depth 6 bpc is only available when using 

RGB color format in DisplayPort or DisplayPort Alt Mode. 

Quantization Range 

VESA: Patterns are sent with Full Range color values (0 to 255 with 8 bpc) 

CTA: Patterns are sent with Limited Range color values (16 to 235 with 8 bpc) 

Quantization range selection is enabled based on the type of pattern selected. 

Video Pattern 

The selection includes a set of predefined patterns and a possibility to load user defined custom 

patterns. Please find a description of the available predefined patterns in Appendix D of this 

document. By selecting Disabled you can have the links activated but no video data transferred. 

Note: When MST mode is selected, full selection of test patterns is available only in virtual channel 0  

Custom Image Patterns 

BMP, PNG, JPG and SVG files can be loaded from the PC to be used as custom images. 

When bitmap patterns are used, they can be used either in their original resolution, aligned to left top 

corner (= un-check Scale), or upscaled or downscaled to match the selected video resolution (= 

check Scale). 

Please refer to Link Pattern in description of Generator role Link tab earlier in this manual for sending 

special binary patterns in the link instead of video.  

Color Depth 

Predefined  

Timings 

Pattern 

in use 
Color format & 

subsampling 

Pattern 

Options 

Colorimetry 

Load pattern Loaded 

pattern 
Bitmap scaling 

Quantization 

Range 
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Pattern Options 

Some of the predefined patterns include additional configuration parameters. The controls for the 

parameters appear below the pattern selection when the pattern in question has been selected. 

Please find a description of patterns options in Appendix D of this document. 

Info 

Info row indicates how much link capacity is being used by the streams and what is the total available 

link capacity. 

Sourcing DSC Compressed Patterns 

UCD Pattern Generator function is able to source DSC content originating from pre-created DSC 

compressed files. DSC compressed pattern files can be created with a separate tool called DSC 

Compressor. It can be launched from Tools > DSC Compressor. 

Please find description of DSC Compressor tool below. Appendix H of this document describes an 

alternative method of generating DSC compressed files. 

DSC Compressor 

Select the source bitmap file in Source File field. Define the Output Resolution, the color depth, 

compression ratio and number of horizontal and vertical slices in the frame. 

Source File: Source bitmap file to be compressed (JPG, PNG, PPM) 

Color Space: Color space of the output compressed file (RGB, YCbCr 4:4:4, 4:2:2, 

4:2:0, Simple 4:2:2) 

Color depth: Color depth of the output compressed file (8, 10, 12, 16) 

Output resolution: Resolution of the output compressed file 

Compression ratio: Used compression ratio 

Horizontal slices: Nr. of slices horizontally 

Vertical slices: Nr. of slices vertically 

Refresh: Refresh the list after adding a custom resolution 

Custom: Create a custom output resolution  

Start compression: Start the compression process 
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Result of the compression process is saved in the same folder as the source file. The start of the file 

name is the same as the source bitmap file; resolution and color format are added to the end of the 

file name. 

Example:  

Default_bitmap_pattern_8K.png >> Default_bitmap_pattern_8K_7680_4320_RGB888_bpc8.dsc. 

 

To use the created DSC file in Pattern Generator, select pattern: Select DSC Image and click Select 

… to open file selection dialog. 

When a DSC image is selected as the pattern, UCD Console will automatically enable DSC, provided 

that the connected Sink device declares support for DSC in its DPCD. 

Note: Please note that the selected video mode has to match the used compressed DSC file. 
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Adaptive-Sync Control 

Adaptive-Sync feature is available for Stream 0. Adaptive-Sync control dialog opens by clicking 

button Adaptive-Sync…. 

Note: Adaptive-Sync is currently limited to 8b/10b link coding and SST mode. 

 

Auto enabled if supported by Sink: The feature is enabled based on connected Sink status 

Disabled: Feature is disabled unless Auto Enabled … box is 

checked. Please see the note below. 

Adaptive Total, constant refresh rate: Added blank lines 

Adaptive Total, Square pattern: Added blank lines, min; Added blank lines, max; Period, 

frames. 

Adaptive VTotal, Zigzag pattern: Added blank lines, min; Added blank lines, max; Increase, 

lines; Decrease, lines. 

Fixed Average VTotal: Target refresh rate, Hz; Increase, lines; Decrease, lines 

 

Note: Please note that in case Auto enabled if supported by Sink is selected and the connected Sink device 

supports Adaptive-Sync, but the selected mode is Disabled, then Adaptive-Sync is enabled in mode 

“Adaptive Total, constant refresh rate” with 0 (zero) added blank lines. Control dialog will be updated 

to indicate the status. 
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Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor by 

clicking Manage Timings. 

Customizing Timings List 

The list of timings that are shown on the pull-down menu in Pattern Generator and Link tabs can be 

limited by un-checking the check-box in the left edge of Name column. The timings will remain in the 

list and can be brought back to the pull-down menu, when needed. 

Editing Timings 

Video timing Name and Description are shown in the list. Lock icon  indicates that a timing is a 

fixed timing which cannot be edited or deleted. Custom timings are indicated with a head icon . 

Copy: Create a new custom timing based on the selected fixed timing. 

Save: Save changes in the selected custom timing. 

 

The dialog will make a sanity check for the values entered and will warn the user for any combinations 

that cannot be used. 
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Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in WAV format.  

To load internally generated audio, select Generate audio, and adjust the controls to the desired 

audio format. 

To load an audio file from your PC, select Load audio from file, click the Open WAV file… button, 

browse and select the file and click Open 

To play the selected audio content, click the Play button. 

The content will be looped until the Stop  button is clicked.  

Audio Status in the top of the tab indicates the type of the currently played audio content.  

Audio Content 

Sent audio can be generated internally or used a WAV file loaded from the PC. 

In case of a WAV audio file, the parameters stored in the file will be used. When generating audio 

internally, the user sets the details of the LPCM Audio signal. 

Waveform Selection of audio waveform: Sine, Sawtooth, Square, or Incremental 

Signal Frequency Setting audio signal frequency in Hz 

Sample Rate (Hz) Selection of audio sampling rate: 32000, 44100 (default), 48000, 

88200, 96000, 176400, 192000 

Bits/Sample Selection of sample bit depth: 16, 24 

Amplitude(%) Selection of audio amplitude: 10%, 20%, …, 90%, 100% 

Channels Selection of sent audio channels: 1, 2, …, 7, 8. 

When selecting 1 or 2 audio channels ‘1 and 2 channel LPCM Audio 

mode’ is used and when 3 and more channels ‘3- to 8-channel LPCM 

Audio mode’ is used. 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 

Status 

The status fields indicate the HDCP status of the UCD device. 

Active: The stream between UCD and the downstream sink has been encrypted. 

Authenticated: HDCP handshake between the UCD and the sink unit has been completed 

successfully. 

Keys loaded HDCP keys are loaded to the UCD unit. 

Configuration 

Enable encryption Check to enable the encryption of the stream between UCD and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD and the sink unit. 

Keys 

Select between Production and Facsimile HDCP keys. To remove the keys, select None.  

HDCP 1.3 vs. HDCP 2.3 

UCD devices support by default HDCP 1.3 and HDCP 2.3. 

Note: With current SW release UCD-500 supports HDCP only when 8b/10b link coding is enabled. 
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EDID Tab 
EDID Tab provides tools for accessing the EDID and Display ID of the connected sink device.  

There are three basic functions: 

• Load and save EDID data files in the host PC 

• Edit the EDID contents either in EDID Editor or in hex format 

• Program and read the contents of the EDID of the sink devices connected 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please note that 

the program does not alter the contents of the EDID file or verify its integrity during load and save 

operation. 

Note: Four blocks (512 bytes) of EDID code are read. If the device is not supporting all four blocks, the non-

supported area is replaced with blanks. 

EDID Editor 

Please see the description of the EDID editor in Chapter EDID Editor later in this document. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the connected DisplayPort or 

DisplayPort Alt Mode Sink. 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

DPCD Decoder flags in Tools > Options contain control of DETAILED_CAP_INFO_AVAILABLE flag 

and MAIN_LINK_CHANNEL_CODING_SET flag. 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes Write the portion of data shown in the window in question to the DPCD registers. 

Set Reference Store currently shown data as a reference for comparison 

 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 

Saving and Loading DPCD Content 

DPCD data in the selected address areas can be saved as a file in your PC. There are two alternative 

formats listed below. Please add the intended format when saving: 

• Binary DPCD Fata File format (*.DPD). This is Unigraf proprietary format. You can also load 

the DPCD content stored in this format. 

• HEX Dump (*.HEX) in a human readable text format. 

Click Save to select the location and the format of the file.  

Click Load to load DPCD data saved in DPCD Data File (*.DPD) format to the editor.  

To program the data into the DPCD registers of the connected sink click Write Changes. 
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FEC Tab 
Forward Error Correction (FEC) can be enabled if connected sink supports it. For debug purposes, 

error injection to main-link is possible. There is an error type for each standard sink DPCD error 

counter.  

Error Generator 

Selections will set how many errors will be inserted into one FEC block and to which link symbols. 

There are five options: 

Uncorrected block 3 symbol errors with 3 error bits together 

Corrected block 2 symbol errors with 2 error bits together 

Corrected parity 2 parity byte errors with 2 error bits together 

Corrected block 1 error  

Corrected parity 1 error  

Note:  FEC must be enabled and running before errors can be added. 

Link training will reset sink FEC error counters. 

Each lane can have its individual error amount. Errors can be injected to even and odd decoders by 

using lane #0 and lane #1 counters when link is configured to one lane. 

Apply Start error injection 

Update Read sink DPCD FEC error counter registers 

Clear counters Clear sink DPCD FEC error counter registers 
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Debug FEC Sequencing with 8b/10b Link Coding 

When 8b/10b link coding is enabled, FEC is an optional features. For FEC debugging in 8b/10b link 

mode UCD Console provides some additional functionalities. 

Send FEC Enable Sequence: When clicked UCD-500 will start adding FEC Enable Sequence in 

its main link data. 

Send FEC Disable Sequence: When clicked UCD-500 will start adding FEC Disable Sequence in 

its main link data. 
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Sink DUT Testing Tab 
Please refer to Appendix E later in this document for description of the tests available.  

Select the tests for execution by clicking the corresponding row. 

Run Selected: Click to start selected tests. By clicking Abort the sequence is stopped. 

Select all: Select all tests in the selected tab. 

Invert selection: Invert selection of tests selected. Hint: To clear all selections, click Select all 

and then Invert selection. 

Configure: Clicking opens a dialog for defining the test parameters for the selected test 

set. Please refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python 

applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail  

Repeats: Repeat the selected test several times 

Delay time: Delay in seconds between individual tests. 

At the completion of each test the result of the test is indicated in the matrix on the right hand side of 

the test panel. For each test the matrix lists the number of occurrences of each result and the number 

of tries performed. 

Save Report: Click to generate a report file in HTML format for sharing the results with other 

parties for viewing without UCD Console. 

Clear Log: Clear the test log and the results matrix 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in Appendix E 

of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console or with TSI 

scripting or sharing. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console or with 

Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… to 

save or recall a configuration.  
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USB-C Monitoring 

When USB-C DP Alt Mode Reference Source role is in use, the following interface specific tabs are 

available. 

• USB-C Power Delivery (PDC) 

When UCD-500 is used in DP Alt Mode Reference Source role, USB-C Power Delivery (PDC) tab is 

available. The content of USB-C Power Delivery tab is similar to the tab available when in UCD-500 

is used in DP Alt Mode Reference Sink role. 

Please refer to chapter USB-C Monitoring in section 4. Analyzer Operation earlier in this document. 
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 EVENT LOG 
Event Log dialog is divided into two panels: the left panel lists all transactions, and the right panel 

shows the parsed transaction data for the line selected in the list on the left. 

 

Role Logged Events 

DP Sink  

DP Alt Mode Sink  

HPD, AUX, SDP, VB-ID, MSA 

DP Source  

DP Alt Mode Source  

HPD, AUX 

DP Alt Mode Sink 

DP Alt Mode Source 

PD, LSE 

 

Start: Starts event logging and stop it by clicking Stop. 

Save: Save transactions as Event Log data as binary or as CSV 

Load: Load saved Event Log data 

Report: Store event logs as reports in HTML format to be shared and viewed with any web 

browser. 

AutoScroll: When selected, transaction list is scrolled vertically, and the latest transaction is 

shown as the last item of the list. When not selected, the items shown before 

clicking Start will be shown. 

Events: Number of events detected 

Colors: Open configure colors dialog 

Clear: Click to clear transaction list. When Clear on Start is selected, the list is cleared 

when clicking Start. 
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Selecting Logged Events  

HPD 

Status and status changes of Hot Plug Detect (HPD) signal, power detection status and cable 

connection status. 

AUX 

Log DP AUX Channel transactions and Sideband Messaging. 

SDP 

Log DP Secondary-data Packets. Click the button to open the Event Filter Dialog. The dialog 

enables filtering of SDP packets. In the dialog, the reference to Packet Type Value is indicated in 

square brackets “[ ]”. 

VB-ID 

Log Vertical Blanking ID packets sent in DP stream. Click the button to open the Event Filter 

Dialog. The dialog enables definition of which events will be logged.  

Logging VB-ID packets will only work when established link is in 8b/10b coding mode. Support for 

logging VB-ID packets in 128b/132b link coding will be added in the future. 
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MSA 

Log Main Stream Attributes sent in DP stream. Click the button to open the Event Filter Dialog. 

The dialog enables logging of all MSA packets and the changes on the selected parameter.  

Logging MSA packets will only work when established link is in 8b/10b coding mode. Support for 

logging MSA packets in 128b/132b link coding will be added in the future.  

PD 

Log USB-C PD communication messages 

LSE 

Low Speed Electrical logger captures the Voltage and Current on the low speed lanes of the  

USB-C connector including CC, VBUS, VCONN, and SBU. 

Event Filter Dialog sets the threshold values for capturing the changes. Parsed transaction data shows 

the captured data with indication of the changed values. 
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Event Transaction List 
Transaction data in Transaction List is ordered in columns. Each column provides additional. 

 

Start: Each line is identified by its timestamp, marking the instant when an event 

or error was detected, or when a data transaction got started.  

The timestamp can be displayed as a time delay from the start of the 

acquisition (absolute) or from the previous line (relative).  

The timestamp can be displayed in milliseconds or in minutes, seconds, 

and microseconds. 

Source and Type The communication port: DP RX to DP TX 

Type The logged item: HPD, SDP, AUX, MSA Change or VB-ID change 

Info This column provides a short description of the message content 

 

When hovering the mouse over the transaction list, a mouse-over window will open. It provides a brief 

list of the content in the transaction under the mouse. 
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Customizing Transaction List 
User Can change what data is shown in the transaction list by adding and removing columns or 

limiting the transaction types in the list. User can also color highlight various types of transactions for 

better readability. 

Right-click on the list to open the menu. 

Configure Start 

The time indicated in column Start can be either: 

• Time from start of the capture 

• Time from previous event 

The time can be expressed either: 

• In microseconds (1/1 000 000 Second) 

• Hours : minutes : seconds : milliseconds : nanoseconds 

Configure Colors 

Configure colors dialog allows the user to highlight various types of transactions in the list by changing 

character color and background color of the transaction line. 

Add: Add a new color highlight rule 

Config: Modify the selected rule 

Remove: Delete the selected rule 

Clone: Duplicate the selected rule 

▲: Change order where rules are applied.  

The rules are applied from the bottom to the top of the list. 
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Adding Rules 

The color highlight rules are set by transaction type. The content of Add rules dialog is dependent on 

the type of item selected. 

Configure Columns 

In the dialog there are two columns: Available and Active. An item from Available list can be included 

in Active columns by selecting it and clicking on the right arrow [>] in the middle of the two columns. 

The order of Active items can be changed by selecting an item and moving its position in the list with 

up ▲and down ▼ arrows. 

Type Filter 

Type filter dialog lists the types of transactions found in the list and allows the user to select which 

transaction lines are currently shown. 

Quick Filter 

By entering a DPCD address in the Quick Filter field on top of the transaction line, the user can limit 

the list to show only the reads or writes to this DPCD address. 
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Event Details 

HPD 

HPD transactions include the following statuses: 

HPD Level: Status of HPD signal: HIGH (Asserted), LOW (De-asserted) 

Power Level:  

(in DP RX) 

Status of source device detection: High (DP Tx detected),  

LOW (DP Tx not detected) 

Cable Detect Level: 

(in DP RX): 

Status of cable detection HIGH (Cable connection detected) LOW 

(Cable connection not detected) 

AUX 

Transaction list includes the following DP AUX Channel transactions. Parsed transactions panel 

provides details for each transaction. 

RD: Native AUX Request Transaction for read 

WR: Native AUX Request Transaction for write 

I2C RD: I2C-over-AUX Request Transaction for read 

I2C WR: I2C-over-AUX Request Transaction for write 

AUX_ACK: AUX Reply Transaction (Request accepted) 

AUX_NACK: AUX Reply Transaction (Request not accepted) 

AUX_DEFER: AUX Reply Transaction (Delayed, new request needed) 

Sideband REQ: Sideband down request message (DOWN_REQ_MSG) 

Sideband REP: Sideband down reply message (DOWN_REP_MSG) 

HDCP Trace 1.X or  

HDCP Trace 2.3: 

HDCP Transmitter and HDCP Receiver communicate DPCD values 

over AUX Channel. Transactions are listed as DPCD Address Range 

Traces where HDCP Port name is indicated. 
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Native AUX Transaction Example 

 Sideband Message Example 

HDCP Trace Example 
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SDP 

DP Secondary-data Packets.  

VB-ID 

Vertical Blanking ID packets sent in DP stream.  

 

MSA 

Main Stream Attributes sent in DP stream.  
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Link Pattern 

Details of the link data 

PD 

USB-C PD communication messages 

LSE 

Status of USB-C Low Speed Electrical signals 
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 EDID EDITOR 
The EDID Editor main window is divided into three logical areas. The bottom part additionally contains 

the command buttons. The top-left portion shows the currently edited E-EDID blocks in a tree-form, 

and the top-right portion shows an edit control for the currently selected item, possibly a list of sub-

keys and their names (The list is not shown for all values) and the HEX-view of the block collection. 

Controls 
Add Item: Add a new EDID or DisplayID block 

Remove Item: Delete the selected EDID or DisplayID block. 

Filter: Show only items having indicated the string in the field name 

Virtual channel: Select virtual channel where EDID is accessed 

Show Read Only: When selected, also automatically created fields are shown 

Recurse: When selected, the whole logical tree of the selected item is 

parsed on the right hand side list. 

The buttons in the bottom of the dialog differ based on the role selected, i.e., is the subject the local 

EDID or EDID of a connected device. 

Read from TE (Analyzer): Read UCD-500 local EDID. 

Write to TE (Analyzer): Program UCD-500 local EDID. 

Download from Sink (Generator): Read EDID of a connected sink device 

Upload to Sink (Generator): Program EDID of a connected sink device 

Load …: Load an EDID block collection file from disk. 

Save As…: Save the current block collection to a disk file. 
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EDID Editor Features 
Practically unlimited number of extension blocks may exist in a single collection. The number of 

blocks is limited by VESA Specifications and possibly by available system resources. Most EDID 

blocks contain a structure that is very similar to a tree-structure. The EDID Editor decodes each block 

into a tree-view of the block. The tree-view then contains all values contained within the EDID block. 

The contents can then be easily browsed, using only a few mouse clicks. The EDID Editor has a 

support for automatic variables, such as the block checksum. When the user changes a value in an 

EDID block, the tool will update the checksum accordingly. The automatic variables appear as read 

only values for the user. A log print will be made when an automatic variable is updated by the editor.  

Editing Tips 
Editing an EDID block is very straightforward, but there are some special cases where the user must 

know how to accomplish certain types of tasks. 

• Double-click the property field to edit 

• Red values in the HEX view indicate a changed value. 

• Enter key will apply text-edit values and combo-box selection. 

• In CTA-861 blocks, you can add and remove 18-byte descriptors and CEA data blocks by 

setting the values “18-byte Descriptors in this block” and “CEA Data block count”.  

• Enter hex values with prefix “0x” or “$”, no prefix means a decimal value. 

• You can always enter HEX or DEC, even if the value is presented as HEX, and/or value range 

is given in HEX. 

• Floating point values must be given with period “.” as decimal separator, even if your 

localization setting defines decimal separator as comma (or other). 

• Remember to click Set after changing a bit-value presented as a single check-box if you want 

the new value applied. 

Note: EDID Editor does not have an Undo function. Therefore, it is highly recommended that you back up 

un-edited EDID contents to a file before editing it. 
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 PACKET EDITOR 
Packet Editor enables creation and editing metadata packets to be included Scenarios played with 

Playback function. 

The types of packets are: 

• Audio InfoFrames (Audio-IF) 

• Auxiliary Video Information InfoFrames (AVI-IF) 

• Custom packets (Custom) 

• Dynamic Range and Mastering InfoFrames (DR&M-IF) 

• Video timing Extended metadata (EMP-VRR) 

• General Control Packet (GCP) 

• Source Product Description InfoFrames (SDP-IF) 

• Vendor-Specific InfoFrames (VSIF) 
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 PATTERN EDITOR 
Pattern Editor is a tool for editing and debugging Unigraf Custom VTP Pattern scripts. 

Please refer to APPENDIX F: VTP PATTERN LANGUAGE later in this document for description of the 

VTP Pattern Language syntax. 

Pattern Editor consists of three tabs: 

Image Tab 

Monitoring the rendering of the VTP pattern script. 

Source Tab 

Tool for editing VTP Pattern Language script. Click Apply to render the code in the resolution of the 

preview image in Image tab. 
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Logs Tab  

Log of the pattern code parsing indicating the values assigned to logical variables and the actual 

parameter values used for render instructions. 

Saving and Recalling the Script 

In File pull-down menu the user can save his work. 

Open: Open a VTP language script from PC 

Save Script: Save the script currently in Source tab to PC 

Save Image: Save a rendered pattern in PNG, BMP, JPG or PPM format 

Select Save Resolution: Select from six common resolutions the size in which the pattern script 

will be rendered when saved. 
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 IMAGE CONVERTER 
Image Converter is a tool for converting images from one color format to another. This kind of 

conversion is typically needed when creating YCbCr test images from RGB bitmaps. 

Image Converter has two operating modes: Standard mode and Advanced mode. In Standard mode 

typical Windows image file formats are used as Source image and the user sets basic color formats 

for the Destination image. In Advanced mode, the user is able to define the Source and Destination 

image parameters in detail. 

Click Select to load the Source image. Click Convert to store the Destination image. File name for 

the Destination image is of form: 

Source_image_1920x1080_8bits_yuv444_lsb.bin 

  

Source_image Name of the image file used as Source image 

1920x1080 Resolution of the Source Image 

8bits Bit depth of the Destination image 

Yuv444 Color space and sampling of the Destination image 

lsb Data alignment of the Destination image 
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APPENDIX A: PRODUCT SPECIFICATION 

UCD-500 

Input 
DisplayPort: DP 2.0/2.1 capable (DP In) (10 Gbps link rate maximum) 

USB-C: PD 3.0 compliant (USB-C In) (20 Gbps link rate maximum) 

Output 
DisplayPort: DP 2.1 compliant (DP Out) (10 Gbps link rate maximum) 

USB-C: PD 3.0 compliant (USB-C Out) (20 Gbps link rate maximum) 

Max video mode 
7680 × 4320 p60 input and output 

15360 × 8640 p60 input and output with DSC 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Content Protection HDCP is supported when 8b/10b link coding is enabled 

DSC Capability 
DSC sink, with off-line decompression 

DSC source using pre-compressed content 

Additional features FEC, LTTPR, DSC 

Computer interface USB 3.0 

Software 
Windows, MacOS, Linux  

UCD Console application, TSI SDK. 

Power supply 
AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +24 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 331mm x 197mm x 66mm 

Weight 1.9kg 

UCD-500 Gen2 

Input 
DisplayPort: DP 2.1 compliant (DP In) (20 Gbps link rate) 

USB-C: PD 3.0 compliant (USB-C In) (20 Gbps link rate) 

Output 
DisplayPort: DP 2.1 compliant (DP Out) (20 Gbps link rate) 

USB-C: PD 3.0 compliant (USB-C Out) (20 Gbps link rate) 

Max video mode 
7680 × 4320 p60 input and output 

15360 × 8640 p60 input and output with DSC 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Content Protection HDCP is supported when 8b/10b link coding is enabled 

DSC Capability 
DSC sink, with off-line decompression 

DSC source using pre-compressed content 

Additional features FEC, LTTPR, DSC 

Computer interface USB 3.0 

Software 
Windows, MacOS, Linux  

UCD Console application, TSI SDK. 

Power supply 
AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +24 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 331mm x 197mm x 66mm 

Weight 1.9kg 
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APPENDIX B: PRODUCT FEATURES 
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DP Reference Sink            

Video status, preview and saving ●         ▲ 

Buffered capture ●         ▲ 

Audio monitoring, graphical preview and saving ●         ▲ 

Link status ●         ▲ 

Link control ●         ▲ 

HPD status and control ●         ▲ 

MST Feature (up to 2 streams) ●         ▲ 

FEC Feature ●         ▲ 

DSC Decoder, DSC Control ●         ▲ 

Adaptive-Sync Feature** ●         ▲ 

DPCD editor ●          

Monitor InfoFrame Status (SDP) ●         ▲ 

EDID read and write ●         ▲ 

EDID / DisplayID Editor ●          

HDCP 1.3 status and control* ●         ▲ 

HDCP 2.3 status and control* ●         ▲ 

Event Log, AUX Analyzer ●         ▲ 

Source DUT Testing (Link and CRC test) ●         ▲ 

DP 1.4 LL, Audio, FEC CTS for testing Source DUT  ●         

DP 2.1 LL CTS for testing Source DUT   ●        

DP 1.4 DSC CTS for testing Source DUT    ●       

DP 2.x DisplayID-EDID CTS for testing Source DUT     ●      

DP 2.x Adaptive-Sync CTS for testing Source DUT**      ●     

HDCP 2.3 CTS for testing DP Source DUT*       ● ●   

HDCP 2.3 CTS for testing DP Repeater DUT*        ●   

DP LTTPR CTS for testing Source DUT         ●  

*) HDCP is supported only when 8b/10b link coding is enabled 

**) Adaptive-Sync is currently limited to 8b/10b link coding and SST mode. 
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DP Reference Source               

Video pattern generator (fixed patterns and timings) ●         ▲ 

Custom video patterns and timings ●         ▲ 

Audio generator ●         ▲ 

Link status ●         ▲ 

Link control ●         ▲ 

HPD status ●         ▲ 

EDID read and write ●         ▲ 

EDID / DisplayID Editor ●          

MST Feature (up to 2 streams) ●         ▲ 

FEC Feature ●         ▲ 

DSC Encoder ●         ▲ 

Adaptive-Sync Feature** ●         ▲ 

DPCD editor ●          

LTTPR Feature ●         ▲ 

HDCP 1.3 status and control* ●         ▲ 

HDCP 2.3 status and control* ●         ▲ 

Event Log, AUX Analyzer ●          

Sink DUT Testing ●          

DP 1.4 LL, Audio and FEC CTS for testing Sink DUT  ●         

DP 2.1 LL CTS for testing Sink DUT   ●        

DP 1.4 DSC CTS for testing Sink DUT    ●       

DisplayID / EDID CTS for testing Sink DUT     ●      

Adaptive-Sync CTS for testing Sink DUT**      ●     

HDCP 2.3 CTS for testing DP Sink DUT*       ● ●   

HDCP 2.3 CTS for testing DP Repeater DUT*        ●   

DP LTTPR CTS for testing Sink DUT         ●  

*) HDCP is supported only when 8b/10b link coding is enabled 

**) Adaptive-Sync is currently limited to 8b/10b link coding and SST mode. 
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UCD-500 Product Options 

Product P/N 

UCD-500 066700 

UCD-500 Gen2 066710 

DP 2.1 LL CTS for testing Sink DUT MT6660 

DP 2.1 LL CTS for testing Source DUT MT6662 

DP 1.4 LL CTS for testing Sink DUT MT6635 

DP 1.4 LL CTS for testing Source DUT MT6637 

DP 1.4 DSC CTS for testing Sink DUT MT6643 

DP 1.4 DSC CTS for testing Source DUT MT6642 

DP DisplayID / EDID CTS for testing Source DUT MT6646 

DP DisplayID / EDID CTS for testing Sink DUT MT6647 

Adaptive-Sync CTS for testing Source DUT MT6648 

Adaptive-Sync CTS for testing Sink DUT MT6649 

DP HDCP 2.3 CTS for testing Source DUT MT6634 

DP HDCP 2.3 CTS for testing Sink DUT MT6636 

DP HDCP 2.3 CTS for testing Sink, Source and Repeater DUT MT6638 

DP LTTPR CTS for testing Source DUT MT6680 

DP LTTPR CTS for testing Sink DUT MT6679 
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APPENDIX C: PREDEFINED TIMINGS 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

VESA 640x480 @ 60Hz (DMT 04h) 640 480 800 525 144 35 96 2 60 25,20 

CTA 720x480 @ 60Hz (VIC 2) 720 480 858 525 122 36 62 6 60 27,03 

CTA 720x480 @ 120Hz (VIC 48) 720 480 858 525 122 36 62 6 120 54,05 

VESA 800x600 @ 60Hz (DMT 09h) 800 600 1056 628 216 27 128 4 60 39,79 

VESA 848x480 @ 60Hz (DMT 0Eh) 848 480 1088 517 224 31 112 8 60 33,75 

VESA 1024x768 @ 60Hz (DMT 10h) 1024 768 1344 806 296 35 136 6 60 65,00 

CTA 1280x720 @ 60Hz (VIC 4) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280x720 @ 120Hz (VIC 47) 1280 720 1650 750 260 25 40 5 120 148,50 

VESA 1280x768 @ 60Hz (DMT 17h) 1280 768 1664 798 320 27 128 7 60 79,67 

VESA 1280x768 @ 60Hz RBv1 1280 768 1440 790 112 19 32 7 60 68,26 

VESA 1280x800 @ 60Hz (DMT 1Ch) 1280 800 1680 831 328 28 128 6 60 83,76 

VESA 1280x800 @ 60Hz RBv1 1280 800 1440 823 112 20 32 6 60 71,11 

VESA 1280x960 @ 60Hz (DMT 20h) 1280 960 1800 1000 424 39 112 3 60 108,00 

VESA 1280x1024 @ 60Hz (DMT 23h) 1280 1024 1688 1066 360 41 112 3 60 107,96 

VESA 1360x768 @ 60Hz (DMT 27h) 1360 768 1792 795 368 24 112 6 60 85,48 

VESA 1400x1050 @ 60Hz (DMT 2Ah) 1400 1050 1864 1089 376 36 144 4 60 121,79 

VESA 1400x1050 @ 60Hz RBv1 1400 1050 1560 1080 112 27 32 4 60 101,09 

CTA 1440x480 @ 59.94Hz (VIC 14) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440x576 @ 50Hz (VIC 29) 1440 576 1728 625 264 44 128 5 50 54,00 

VESA 1600x1200 @ 60Hz (DMT 33h) 1600 1200 2160 1250 496 49 192 3 60 162,00 

VESA 1600x1200 @ 60Hz RBv1 1600 1200 1760 1235 112 32 32 4 60 130,42 

CTA 1680x720 @ 60Hz (VIC 83) 1680 720 2200 750 260 25 40 5 60 99,00 

CTA 1680x720 @ 120Hz (VIC 85) 1680 720 2000 825 260 100 40 5 120 198,00 

VESA 1680x1050 @ 60Hz (DMT 3Ah) 1680 1050 2240 1089 456 36 176 6 60 146,36 

VESA 1680x1050 @ 60Hz RBv1 1680 1050 1840 1080 112 27 32 6 60 119,23 

VESA 1792x1344 @ 60Hz (DMT 3Eh) 1792 1344 2448 1394 528 49 200 3 60 204,75 

VESA 1856x1392 @ 60Hz (DMT 41h) 1856 1392 2528 1439 576 46 224 3 60 218,27 

VESA 1920x1080 @ 30Hz RBv1 1920 1080 2080 1096 112 13 32 5 30 68,39 

VESA 1920x1080 @ 30Hz RBv2 1920 1080 2000 1096 72 14 32 8 30 65,76 

CTA 1920x1080 @ 30Hz (VIC 34) 1920 1080 2200 1125 192 41 44 5 30 74,25 

VESA 1920x1080 @ 60Hz (DMT 52h) 1920 1080 2200 1125 192 41 44 5 60 148,50 

VESA 1920x1080 @ 60Hz RBv1 1920 1080 2080 1111 112 28 32 5 60 138,65 

VESA 1920x1080 @ 60Hz RBv2 1920 1080 2000 1111 72 14 32 8 60 133,32 

CTA 1920x1080 @ 60Hz (VIC 16) 1920 1080 2200 1125 192 41 44 5 60 148,50 

*) CVT: Coordinated Video Timings (CVT; VESA-2013-3 v1. 2) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 

Other: Unigraf proprietary timing 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

VESA 1920x1080 @ 120Hz RBv1 1920 1080 2080 1144 112 61 32 5 120 285,54 

VESA 1920x1080 @ 120Hz RBv2 1920 1080 2000 1144 72 14 32 8 120 274,56 

CTA 1920x1080 @ 120Hz (VIC 63) 1920 1080 2200 1125 192 41 44 5 120 297,00 

VESA 1920x1440 @ 60Hz (DMT 45h) 1920 1200 2592 1245 536 42 200 6 60 193,62 

VESA 1920x1440 @ 60Hz (DMT 49h) 1920 1440 2600 1500 552 59 208 3 60 234,00 

VESA 2048x1536 @ 60Hz RBv1 2048 1536 2208 1580 112 41 32 4 60 209,32 

VESA 2560x1080 @ 60Hz CVT 2560 1080 3424 1120 704 37 272 10 60 230,09 

VESA 2560x1080 @ 60Hz RBv1 2560 1080 2720 1111 112 28 32 10 60 181,32 

CTA 2560x1080 @ 60Hz (VIC 90) 2560 1080 3000 1100 192 16 44 5 60 198,00 

CTA 2560x1080 @ 120Hz (VIC 92) 2560 1080 3300 1250 192 166 44 5 120 495,00 

VESA 2560x1440 @ 60Hz RBv1 2560 1440 2720 1481 112 38 32 5 60 241,70 

VESA 2560x1440 @ 60Hz RBv2 2560 1440 2640 1481 72 14 32 8 60 234,59 

VESA 2560x1600 @ 60Hz (DMT 4Ch) 2560 1600 3504 1658 752 55 280 6 60 348,58 

VESA 2560x1600 @ 60Hz RBv1 2560 1600 2720 1646 112 43 32 6 60 268,63 

Other 2880x1440 @ 60Hz 2880 1440 2976 1456 48 8 8 1 60 259,98 

VESA 3840x2160 @ 30Hz RBv1 3840 2160 4000 2191 112 28 32 5 30 262,92 

VESA 3840x2160 @ 30Hz RBv2 3840 2160 3920 2191 72 14 32 8 30 257,66 

CTA 3840x2160 @ 30Hz (VIC 95) 3840 2160 4400 2250 384 82 88 10 30 297,00 

CTA 3840x2160 @ 50Hz (VIC 96) 3840 2160 5280 2250 384 82 88 10 50 594,00 

VESA 3840x2160 @ 60Hz RBv1 3840 2160 4000 2222 112 59 32 5 60 533,28 

VESA 3840x2160 @ 60Hz RBv2 3840 2160 3920 2222 72 14 32 8 60 522,61 

VESA 3840x2160 @ 60Hz RBv3 3840 2160 4000 2222 152 14 32 8 60 533,47 

CTA 3840x2160 @ 60Hz (VIC 97) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 4096x2160 @ 50Hz (VIC 101) 4096 2160 5280 2250 216 82 88 10 50 594,00 

VESA 4096x2160 @ 60Hz RBv1 4096 2160 4256 2222 112 59 32 10 60 567,41 

VESA 4096x2160 @ 60Hz RBv2 4096 2160 4176 2222 72 14 32 8 60 556,74 

VESA 4096x2160 @ 60Hz RBv3 4096 2160 4256 2222 152 14 32 8 60 567,61 

CTA 4096x2160 @ 60Hz (VIC 102) 4096 2160 4400 2250 216 82 88 10 60 594,00 

VESA 3840x2160 @ 120Hz RBv1 3840 2160 4000 2287 112 124 32 5 120 1097,76 

VESA 3840x2160 @ 120Hz RBv2 3840 2160 3920 2287 72 14 32 8 120 1075,80 

CTA 3840x2160 @ 120Hz (VIC 118) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

VESA 5120x2160 @ 30Hz RBv1 5120 2160 5280 2191 112 28 32 10 30 347,05 

VESA 5120x2160 @ 30Hz RBv2 5120 2160 5200 2191 72 14 32 8 30 341,80 

CTA 5120x2160 @ 30Hz (VIC 123) 5120 2160 6000 2200 216 32 88 10 30 396,00 

VESA 5120x2160 @ 60Hz RBv1 5120 2160 5280 2222 112 59 32 10 60 703,93 

VESA 5120x2160 @ 60Hz RBv2 5120 2160 5200 2222 72 14 32 6 60 693,26 

CTA 5120x2160 @ 60Hz (VIC 126) 5120 2160 5500 2250 216 82 88 10 60 742,50 

*) CVT: Coordinated Video Timings (CVT; VESA-2013-3 v1. 2) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 

Other: Unigraf proprietary timing 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

VESA 5120x2160 @ 120Hz RBv1 5120 2160 5280 2287 112 124 32 10 120 1449,04 

VESA 5120x2160 @ 120Hz RBv2 5120 2160 5200 2287 72 14 32 8 120 1427,09 

CTA 5120x2160 @ 120Hz (VIC 193) 5120 2160 5500 2250 216 82 88 10 120 1485,00 

VESA 5120x2880 @ 60Hz RBv1 5120 2880 5280 2962 112 79 32 5 60 938,36 

VESA 5120x2880 @ 60Hz RBv2 5120 2880 5200 2962 72 14 32 8 60 924,14 

VESA 5120x2880 @ 60Hz RBv3 5120 2880 5280 2962 152 14 32 8 60 938,69 

CTA 7680x4320 @ 24Hz (VIC 194) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

VESA 7680x4320 @ 30Hz RBv1 7680 4320 7840 4381 112 58 32 5 30 1030,41 

VESA 7680x4320 @ 30Hz RBv2 7680 4320 7760 4381 72 14 32 8 30 1019,90 

CTA 7680x4320 @ 30Hz (VIC 196) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

VESA 7680x4320 @ 60Hz RBv1** 7680 4320 7840 4443 112 120 32 5 60 2089,99 

VESA 7680x4320 @ 60Hz RBv2** 7680 4320 7760 4443 72 14 32 8 60 2068,66 

CTA 7680x4320 @ 60Hz (VIC 199)** 7680 4320 9000 4400 768 64 176 20 60 2376,00 

VESA 7680x4320 @ 100Hz RBv1** 7680 4320 7840 4529 112 206 32 5 100 3550,74 

VESA 7680x4320 @ 100Hz RBv2** 7680 4320 7760 4529 72 14 32 8 100 3514,50 

CTA 7680x4320 @ 100Hz (VIC 200)** 7680 4320 10560 4500 768 164 176 20 100 4752,00 

 

*) CVT: Coordinated Video Timings (CVT; VESA-2013-3 v1. 2) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 

Other: Unigraf proprietary timing 

**)  Currently timings with pixel clock higher than 1520 MHz are not supported   



  Appendix D: Predefined Patterns 

UCD-5XX Console User Manual v2 94. 

APPENDIX D: PREDEFINED PATTERNS 

Fixed Patterns 

Selection Pattern Description 

Disabled 

 

The links are activated but no video data transferred 

Color Bar 

 

100% intensity color bars of all primaries and mixed combinations. 

Chessboard 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Color 

 

Solid color. User selected RGB values 

Solid White 

 

100% white 

Solid Red 

 

100% red 

Solid Green 

 

100% green 

Solid Blue 

 

100% blue 

White V-Strips 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in pixels 

respectively. Default black / white = 20 / 20 pixels. Parameter range 

1 to 1000. 

RGB Wide Strips 

 

16 pixels high horizontal red, green, blue, and white stripes. 

Intensity is increased from 0 to 100% with steps defined by the 

given parameter (Color Step = cs) and selected color.  

(step = cs*color_depth/256). “n” range 0 to 5000 (default 100). 

Color Ramp 

 

Color Ramp test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. 

Color Square 

 

Color Square test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. Color mode can be selected 

between RGB, YCbCr 4:4:4, 4:2:2, 4:2:0 (ITU Rec 601 / 709) 

Motion Pattern 

 

Horizontally moving color bar pattern. The pattern is shifted to left 

one pixel in each frame in a sequence. The length of the sequence 

is defined with parameter. Range 0 to 34 (default is 20) 

Square Window 

 

100% intensity white square horizontally and vertically centered. 

Height and width defined by parameter as the percentage of height 

and width of the frame (default 30). 
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Extended Patterns 

Selection Icon Description 

Select Image 
 

Custom image uploaded by the user. Click on Select … to browse. 

Select DSC Image 
 

Custom DSC compressed image file uploaded by the user.  

Click on Select … to browse. 

Unigraf PM5544 
 

Vpattern vector pattern based on PM5544 

Color Web 
 

Vpattern vector pattern. 

Chinese Town Full HD 
 

JPG Bitmap image (1920 x 1080 px) 

UG-2111 HLG Narrow 
 

Software generated pattern. HLG Narrow dynamic range. 

UG-2111 PQ Narrow 
 

Software generated pattern. PQ Narrow dynamic range. 

UG-2111 PQ Full 
 

Software generated pattern. PQ Full dynamic range. 

Multi 
 

Vpattern vector pattern. Multi-purpose pattern w square grid, cross-grids, 

1x1 cross-hatches, circles, and color bars 

SMPTE RP-133 
 

Vpattern vector pattern based on SMTPE RP-133 

SMPTE 303M 
 

Vpattern vector pattern. SMPTE 303M; Full Range; RGB values before 

gamma correction based on D65 and PAL primaries 

Blue 
 

Vpattern vector pattern. 100% Blue 

CirclesW 
 

Vpattern vector pattern. Concentric circles 

Complex 
 

Vpattern vector pattern. Complex Pattern w 64 steps 

Green 
 

Vpattern vector pattern. 100% Green 

Hor1W-Even 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in even rows 

Hor1W-Odd 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in odd rows 

Hor4W 
 

Vpattern vector pattern. Horizontal 4 px high White bars 

Hor10W 
 

Vpattern vector pattern. Horizontal 10 px high White bars 

Hor-10xB 
 

Vpattern vector pattern. 10 pcs horizontal Blue bars 

Hor-10G 
 

Vpattern vector pattern. 10 pcs horizontal Green bars 
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Extended Patterns (cont.) 

Selection Icon Description 

Hor-10xR 
 

Vpattern vector pattern. 10 pcs horizontal Red bars 

Hor-10xW 
 

Vpattern vector pattern. 10 pcs horizontal White bars 

HorRainbow-1024 
 

Vpattern vector pattern. Horizontal Rainbow Ramps 1024 steps 

HorRGBW-1024 
 

Vpattern vector pattern. Horizontal RGBW Ramps 1024 steps 

HorScale9 
 

Vpattern vector pattern. Nine Horizontal Color Ramps 

HorScaleW-64 
 

Vpattern vector pattern. Horizontal White ramp 64 steps 

HorScaleW-128 
 

Vpattern vector pattern. Horizontal White ramp 128 steps 

HorScaleW-X2 
 

Vpattern vector pattern. Horizontal White ramp w edges 128 steps 

InnerBox-BKtoB 
 

Vpattern vector pattern. InnerBox pattern from Black to Blue 

InnerBox-BKtoG 
 

Vpattern vector pattern. InnerBox pattern from Black to Green 

InnerBox-BKtoR 
 

Vpattern vector pattern. InnerBox pattern from Black to Red 

InnerBox-BKtoW 
 

Vpattern vector pattern. InnerBox pattern from Black to White 

InnerBoxMIX 
 

Vpattern vector pattern. InnerBox pattern mixed hues. 

InnerBox-RtoB 
 

Vpattern vector pattern. InnerBox pattern from Red to Blue 

Red 
 

Vpattern vector pattern. 100% Red 

Ver1W-Even 
 

Vpattern vector pattern. Vertical 1 px wide White bars in even columns 

Ver1W-Odd 
 

Vpattern vector pattern. Vertical 1 px wide White bars in odd columns 

Ver4W 
 

Vpattern vector pattern. Vertical 4 px wide White bars 

Ver10W 
 

Vpattern vector pattern. Vertical 10 px wide White bars 

Ver-10xG 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xR 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xB 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xW 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 
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Extended Patterns (cont.) 

Selection Icon Description 

VerBars75% 
 

Vpattern vector pattern. Vertical 75% intensity Color bars 

VerBars100% 
 

Vpattern vector pattern. Vertical 100% intensity Color bars 

VerRGBW-1024 
 

Vpattern vector pattern. Vertical RGBW Ramps 1024 steps 

X-HatchBK-C 
 

Vpattern vector pattern. Black 16 x12 Grid w Circle on White background 

X-HatchW 
 

Vpattern vector pattern. White 16 x12 Grid on Black background 

X-HatchW-C 
 

Vpattern vector pattern. White 16 x12 Grid w Circle on Black background 

X-HatchW-CC 
 

Vpattern vector pattern. White 16 x12 Grid w Ellipses, Circle and 100% 

color bars 

Gray Box 10 

 

Vpattern vector pattern. China 5.6 White Window 10% 

Gray Box 20 

 

Vpattern vector pattern. China 5.6 White Window 20% 

Gray Box 30 

 

Vpattern vector pattern. China 5.6 White Window 30% 

Gray Box 40 

 

Vpattern vector pattern. China 5.6 White Window 40% 

Gray Box 50 

 

Vpattern vector pattern. China 5.6 White Window 50% 

Gray Box 60 

 

Vpattern vector pattern. China 5.6 White Window 60% 

Gray Box 70 

 

Vpattern vector pattern. China 5.6 White Window 70% 

Gray Box 80 

 

Vpattern vector pattern. China 5.6 White Window 80% 

Gray Box 90 

 

Vpattern vector pattern. China 5.6 White Window 90% 

Gray Box 100 

 

Vpattern vector pattern. China 5.6 White Window 100% 

8 Level Gray 

 

Vpattern vector pattern. China 5.5 Ultimate 8 Level Grayscale 
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Extended Patterns (cont.) 

Selection Icon Description 

Black'n'White Window 

HDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR HDTV) 

Black'n'White Window 

SDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR SDTV) 

Black Line HDTV 

 

Vpattern vector pattern. China 5.10 Black Line HDTV 

Black Line SDTV 

 

Vpattern vector pattern. China 5.10 Black Line SDTV 

Black Window 

 

Vpattern vector pattern. China 5.7 Black Window 

Check Board 
 

Vpattern vector pattern. China 5.9 Check Board 

Line'n'Window 

 

Vpattern vector pattern. China 5.11 Line and Window 

Narrow White Window 

 

Vpattern vector pattern. China 5.19 Narrow White Window 

Single Dot 

 

Vpattern vector pattern. China Single Dot 

White Line HDTV 

 

Vpattern vector pattern. China 5.10 White Line for HDTV 

White Line SDTV 

 

Vpattern vector pattern. China 5.10 White Line for SDTV 

 

More test patterns can be downloaded e.g. from www.icdm-sid.org/downloads/testpatterns.html. 
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APPENDIX E: SINK, SOURCE AND REPEATER TESTS 

 

Source DUT Testing 
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Audio Test 
Validate audio signal frequency and glitch-free audio 

reproduction 
●    

   
 

CRC Video Tests 

CRC based single frame reference video test, 

CRC based single frame stability test,  

CRC based sequence of frames reference video test,  

CRC based continuous sequence of frames reference 

video test 

●    

   

 

DP 1.4a Link Layer CTS  

4.2.1.1 – 4.2.1.5, 4.2.2.1 – 4.2.2.10, 4.3.1.1 – 4.3.1.13,  

4.3.2.1 – 4.3.2.5, 4.3.3.1, 4.4.1.1 – 4.4.1.3, 4.4.2, 4.4.3, 

4.4.4.2 – 4.4.4.6, 4.5.1.1 – 4.5.1.2 

 ●   

   

 

DP 1.4a DSC CTS 4.6.1.1 – 4.6.1.9   ●      

DP 2.1 Link Layer CTS 
4.2.2.11 – 4.2.2.12; 4.3.1.1 – 4.3.1.5; 4.3.1.14 – 

4.3.1.23 
   ● 

   
 

DP 2.x DisplayID-EDID LL CTS*** 
4.7.1.1 – 4.7.1.4, 4.7.2.1 – 4.7.2.2, 4.7.3.1 – 4.7.3.3, 

4.7.4.1 
    ● 

  
 

DP 2.x Adaptive-Sync LL CTS**** 4.8.1.1 – 4.8.1.2, 4.8.2.1 – 4.8.2.2      ●   

DP LTTPR CTS 4.9.1.1 – 4.9.1.23       ●  

DP HDCP 2.3 CTS 1A Test Set** HDCP2.3 CTS 1A-01 – HDCP2.3 CTS 1A-12        ● 

DP HDCP 2.3 CTS 1B Test Set** HDCP2.3 CTS 1B-01 – HDCP2.3 CTS 1B-10        ● 

Link Config Tests  
Link Training at All Supported Lane Counts and Link 

Rates 
●    

   
 

Pixel Level Video Tests Compare video frame sequence with a single reference ●        

*) Separate licenses for testing Sink, Source, Branch (LL CTS, DSC) DUT 

**) HDCP is supported only when 8b/10b link coding is enabled 

***) Unigraf UCD-400 was used by VESA for TE correlation of the tests 

****) Adaptive-Sync is currently limited to 8b/10b link coding and SST mode. Unigraf UCD-400 was used by VESA 

for TE correlation of the tests 
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Sink DUT Testing  
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DP 1.4a Link Layer CTS  

5.2.1.1 – 5.2.1.12, 5.2.2.1 – 5.2.2.9, 5.3.1.1 – 5.3.1.9,  

5.3.2.1 – 5.3.2.2, 5.4.1.1 – 5.4.1.4, 5.4.2, 5.4.3.1 – 

5.4.3.2, 5.4.4.1 – 5.4.4.6, 5.5.1.1 – 5.5.1.7 

 ●     

 

 

DP 1.4a DSC CTS 5.6.1.1 – 5.6.1.26, 5.6.2.1 – 5.6.2.14   ●      

DP 2.1 Link Layer CTS 
5.2.1.8 – 5.2.1.12, 5.2.2.1 – 5.2.2.3, 5.2.2.5 – 5.2.2.9, 

5.3.1.1 – 5.3.1.15, 5.3.2.1 – 5.3.2.2, 5.5.1.1 – 5.5.1.12  
   ●   

 
 

DP 2.x DisplayID-EDID LL CTS*** 

5.7.11 – 5.7.1.2, 5.7.1.3.1 – 5.7.1.3.4, 5.7.1.4.1 – 

5.7.1.4.9, 5.7.1.5, 5.7.2.1 – 5.7.2.3.5, 5.7.4.1 – 5.7.4.2, 

5.7.2.5.1 – 5.7.2.5.2, 5.7.2.6.1 – 5.7.2.6.2, 5.7.2.7.1, 

5.7.2.8, 5.7.3.1 – 5.7.3.5, 5.7.4.1 – 5.7.4.3, 5.7.4.5, 

5.7.5.1, 5.7.6.1 – 5.7.6.5, 5.7.7.1 – 5.7.7.6, 5.7.8.1 – 

5.7.8.6, 5.7.9.1 – 5.7.9.3, 5.7.10.1 – 5.7.10.3, 

5.7.12.1 – 5.7.12.3 

    ●  

 

 

DP 2.x Adaptive-Sync LL CTS**** 5.8.1.1 – 5.8.1.3 (Tests are in VESA correlation)      ●   

DP LTTPR CTS 5.9.1.1 – 5.9.1.15       ●  

DP HDCP 2.3 CTS 2C Test Set** HDCP2.3 CTS 2C-01 – HDCP2.3 CTS 2C-06        ● 

*) Separate licenses for testing Sink, Source, Branch (LL CTS, DSC) DUT 

**) HDCP is supported only when 8b/10b link coding is enabled 

***) Unigraf UCD-400 was used by VESA for TE correlation of the tests 

****) Adaptive-Sync is currently limited to 8b/10b link coding and SST mode. Unigraf UCD-400 was used by VESA 

for TE correlation of the tests 

 

 

Repeater DUT Testing 
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DP HDCP 2.3 CTS 3A Test Set** HDCP2.3 CTS 3A-01 – HDCP2.3 CTS 3A-06  ● 

DP HDCP 2.3 CTS 3B Test Set** HDCP2.3 CTS 3B-01 – HDCP2.3 CTS 3B-07  ● 

DP HDCP 2.3 CTS 3C Test Set** HDCP2.3 CTS 3C-01 – HDCP2.3 CTS 3C-25  ● 

*) Separate licenses for testing Sink, Source, Branch (LL CTS) and Repeater (HDCP) DUT 

**) HDCP is supported only when 8b/10b link coding is enabled 
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Compliance Tests 

Compliance test capability is a license enabled add-on to UCD Console. The tests are included in the 

GUI software, license codes enable the tests for use.  

Please refer to Appendix B Licensing for details. The list of compliance tests that UCD Console 

supports, please refer to document DP CTS Tool Options for Unigraf UCD-500.pdf. It can be 

downloaded in Unigraf Document Center at https://www.unigraf.fi/documents/. If you have any 

additional questions, please contact Unigraf or your local representative. 

Compliance tests (CTS Tests) are part of tests included in Source DUT Testing tab of DP RX and 

Sink DUT Testing tab of DP TX. 

The tests cases are divided to test categories as described in Appendix E of this document. Test 

categories are placed in sub-tabs. Test category tabs are enabled based on licenses present. Please 

refer to chapter 3 License Manager earlier in this document. 

Test Parameters 

Before running the tests, capabilities of the DUT have to be defined for the test engine. Each test 

category has its dedicated test parameter dialog. Click Configure in Source DUT Testing or Sink 

DUT Testing tab to open the parameter dialog. 

For a detailed description of capabilities listed on the tab please refer to Chapter 3 Compliance Test 

Operation of document VESA DisplayPort Link Layer Compliance Test Specification. 

Note: Please make sure that the capability tables are completed before running the tests. The result of the 

test might be misleading if the DUT capabilities and the table do not match. 

  

https://www.unigraf.fi/documents/
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DSC Test Content 

When running DSC Compliance Tests, Console needs to have access to DSC content used as test 

patterns. The content needed by the test will be created from the source bitmap files downloaded 

during installation (optional).  

Creation of the test content will take time and considerably slow down the execution of the test. In 

order to avoid this user is able to create the DSC content in advance by using a batch file stored 

during installation. The batch file can be found by default here: 

C:\ProgramData\Unigraf\DSC_content_library\generate_all_dsc_files.bat 

The batch file will additionally need a tool called ImageMagick 

 Download and install ImageMagick from the authoritative website 

https://imagemagick.org/script/download.php 

Please download for example the following version for Windows use: 

ImageMagick-7.1.0-28-Q16-x64-static.exe Win64 static at 16 bits-per-pixel component 

 From the install folder of ImageMagick please copy magick.exe and ffmpeg.exe to 

C:\ProgramData\Unigraf\DSC_content_library 

 Run the batch file 

Warning Please note, that the space needed for storing the full library can be very large 

(appr. 100 GBytes). Please make sure that the content will be stored in a medium that has the 

required space available. 

Options 

In Tools > Options menu you can define DSC Work folder and DSC test content directory.  

DSC temp folder Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related 

configuration files and DSC conversion tools are stored. 

Automatically create missing content When selected, compliance test tool During execution of 

DSC Compliance Tests, the tool automatically creates the 

DSC compressed content used for testing the DUT. 

Keep auto-created By default, the DSC compressed content is deleted after 

use. If selected, the content is not deleted 

Warning Keeping the automatically created DSC compressed content will shorten the time needed for running 

the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large 

(appr. 100 GBytes). Please make sure that the content will be stored in a medium that has the 

required space available. 
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Running CTS Tests 
Source DUT Testing and Sink DUT Testing tabs include the tests enabled with the set of licenses 

present in UCD Console grouped in test set tabs. In tabs the tests are listed by the test name and 

reference number as in applicable compliance test specification. UCD-500 firmware implements the 

test according to the test specification.  

Test flow parameters like Test timeout and Test cycle delay can be defined in Test Parameter dialog 

launched by clicking Configure. 

Select the tests for execution by clicking the corresponding row. For selecting multiple consecutive 

tests in the list hold down the Shift key of your keyboard while selecting the tests. For selecting 

multiple individual tests hold down the Ctrl key in your keyboard while selecting. 

Run Selected Click to start selected tests. By clicking Abort the sequence is stopped. 

Select all: Select all tests in the selected tab. 

Invert selection Invert selection of tests selected. Hint: To clear all selections, click Select all 

and then Invert selection. 

Configure Clicking opens a dialog for defining the test parameters for that set. Please 

refer to Test Parameters below for description. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For 

saving parameters for TSI scripting, please use *.td files. For use with Python 

applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail 

Repeats: Repeat the selected test several times. 

When repeating a sequence of tests, all selected tests are performed in each 

repetition. E.g., when you repeat tests 1, 2 and 3 two times, the sequence is: 

1, 2, 3, 1, 2, 3. 

Delay time Delay in seconds between individual tests. 

 

Save Report: Click to generate a report file in HTML format for sharing the results with 

other parties for viewing without UCD Console. 

Clear Log Clear the test log and the results matrix 
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Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console or with TSI 

scripting or sharing. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console or with 

Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… to 

save or recall a configuration 

Operator Feedback 

In some compliance tests operator action or feedback is required for items that the test itself cannot 

perform or confirm. In these cases test opens a pop-up dialog. In the dialog the operator is instructed 

about items to do or to be verified and buttons for providing the “Proceed” instruction or “Pass” and 

“Fail” feedback. 

Clicking “Abort” stops execution of the test. 
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Evaluating CTS Test Results 

The test procedure advancement can be monitored in the Test Log panel. It describes the steps of 

each individual test in the way defined in the corresponding VESA Compliance Test Specification. 

Please use the Status Log and Specification side by side when interpreting the results. 

At the completion of each test the result of the test is indicated in the matrix on the right hand side of 

the test panel. For each test the matrix lists the number of occurrences of each result and the number 

of tries performed. 
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Test Report 
Results of the test can be saved as a report in HTML format.  

Viewing the CTS Test Report 

The report file can be viewed with any HTML browser. The report has built-in views for Report 

Summary, Test Summary and individual tests. 
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Audio Test Set 

Validate audio signal frequency and glitch-free audio reproduction 

Perform frequency check on the digital audio content and verify the content to be glitch-free. This 

test assumes that a pure sine-wave audio signal content is being transmitted to the test equipment. 

The test will first capture minimum of one second of audio content. The audio is then analyzed in two 

stages.  

First, the power spectrum is calculated, and the highest peak must be within the defined window. 

Resolution of the peak frequency check is better than ±1 Hz.  

In the second stage, received audio is checked for random glitches, such as dropped or duplicated 

samples. This is achieved by examining how the RDV (“Relative Distortion Value”) changes over time 

within the sampled audio. 

The test is considered passed if power of audio content spectrum has its maximum within the defined 

window, and the number of detected audio glitches does not exceed programmed limit. 

Parameters in use 

▪ Expected sampling rate of audio signal (default 44 100 s/sec) 

▪ Expected audible (sine) frequency in Hz (default 1000 Hz) 

▪ Allowed deviation from expected frequency in Hz (default 1 Hz) 

▪ Number of audio glitches allowed per test (default 0) 

▪ Tested audio save conditions (Save none / Save failed / Save all) 

 

Click Location where the captured audio is to be saved to browse for the folder to store tests  
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CRC Based Video Test Set 

CRC Based Single Reference Frame Video Test 

The test compares captured frames to a captured reference. In Configure dialog, please select 1 to 

CRC Capture length and click Capture Now. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to provided 

parameters and after that captures frames and compares the CRC (check sum) of their three color 

components to the provided reference until the number of bad frame limit provided is detected or the 

provided total number of frames is reached.  

The test is judged FAIL if video mode does not match, or the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Total number of frames (default 2 000 ms) 

▪ Number of bad frames allowed (default 2) 

▪ Reference width (default 1920) 

▪ Reference height (default 1080) 

▪ Reference BPP (default 24) 

▪ Expected frame rate (mHz, Hz/1000) 

▪ Frame rate tolerance (mHz, Hz/1000)) 

▪ Reference CRCs (R, G, B) 
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CRC Based Single Frame Video Stability Test 

The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE captures 

frames and compares their CRC (check sum) to the reference until the number of bad frame limit 

provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Total number of frames (default 2 000 ms) 

▪ Number of bad frames allowed (default 2) 

CRC Based Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to provided 

parameters. After that captures frames to find a frame with matching CRC (check sum) of their three 

color components to the first provided reference. After the first matching CRC is found it compares 

the CRC of the following frames until the Number of frames tested parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 100 000 ms) 

• Number of frames to be tested (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, Hz/1000) 

• Frame rate tolerance (mHz, Hz/1000) 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 
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CRC Based Continuous Sequence of Reference Frames Test 

The test verifies that a sequence of frames is captured in the right order many times repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and Color format) 

to provided parameters. After that captures frames to find a frame with matching CRC (check sum) 

of their three color components to the first provided reference. After the first matching CRC is found 

it compares the CRC of the following frames until the Number of frames tested parameter is reached. 

After that it resets the list and starts from the first CRC. The list is repeated until timeout or until the 

provided number of repetitions is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 100 000 ms) 

• Number of frames to be tested (default 20) 

• Number of iterations 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, Hz/1000) 

• Frame rate tolerance (mHz, Hz/1000) 

• Expected color format 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 
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Link Config Tests 

Link Training at All Supported Lane Counts and Link Rates 

Test requests link training on all supported lane counts and link rates. Each link training must be 

successfully completed in order to pass the test. 

In Configure, please define the parameters for the test. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Max lane count supported by DUT (default 4) 

• Max lane rate supported by DUT 

• Long HPD pulse duration (default 1 000 ms) 

• Link training start timeout (default 5 000 ms) 

• Delay between test cycles (default 3 000 ms) 
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Pixel Level Video Tests 

Compare video frame sequence with a single reference 

The test compares captured frames to the provided reference image on pixel level by buffering the 

indicated number of captured frames first in UCD-500 and after that downloads them to the PC for 

evaluation. 

The test compares the captured frames to a provided reference image on pixel level.  

• Color component values of each pixel in the captured frame is compared to the 

corresponding pixels in the reference image.  

• If the difference is larger than the provided tolerance, the pixel is considered failed. 

• If the number of failed pixels in a frame is larger than the provided tolerance, the frame is 

considered failed. 

• If the number of failed frames in the test is larger than the provided tolerance, the test is 

considered failed. 

• Failed frames can be stored for evaluation. 

Load image: Load the reference image 

Image resolution: Video resolution expected 

Image format: Image format expected 

Bits per component: Bits per component expected 

Data format: Video data format expected 

Frames count: Number of frames buffered for testing 

Maximum number of failed frames 

allowed per test: 

Number of failed frames allowed totally 

Maximum number of failed frames 

allowed per test: 

Number of failed pixels allowed per buffered frame 

Tolerance between pixel values: The allowed difference between a color component of 

pixel in the captured frame to the reference bitmap. 

Maximum number of exported frames: Maximum number of failed frames stored to PC 

Folder to save failed frames: PC folder where failed frames are stored. 

Presets: Store and recall settings 
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APPENDIX F: VTP PATTERN LANGUAGE 

General 
The Vpattern definition language (in the following simply “VTP”) is a straightforward yet flexible way 

of describing test patterns for UCD Generators. This description is providing an introduction and 

examples of the most usable instructions and parameters.  

The VTP language uses text command syntax. Each row represents one drawing instruction. The 

coordinate system can be either absolute or scaled. In the absolute mode the actual pixel position is 

referred while in the scaled mode the coordinates refer to the “Drawing resolution” used while 

drawing. For both absolute and scaling coordinates the origin is the upper left hand corner of the 

screen. 

Terminology 

The following terms are used in this document: 

Coordinate system: two numerical ranges of integer, positive numbers. E.g. {0,799},{0,599} or 

{0,10000},{0,10000}. 

Coordinates: a tuple of integer, positive numbers used to address a position on an image, e.g. 

(100,250). The first number is the horizontal position, the second one the vertical position. The actual 

position is always related to the coordinate system currently in use 

Drawing resolution: the width and height of the space that can be used for drawing, expressed in 

pixels. E.g., 2560 by 1600. 

Drawing area: a 2-dimensional area spanning all of the drawing resolution, expressed in the current 

coordinate system notation. E.g., if the drawing resolution is 800 x 600 pixels, the drawing area 

includes all points (x,y) where x = 0 to 799 and y = 0 to 599 in ABSOLUTE mode or x = 0 to 10000 

and y = 0 to 10000 in SCALED mode. 

Notation 

The following notation is used in this document: 

• A token is enclosed by characters ‘<’ and ‘>’. For instance, <variable> represents a generic 

variable. 

• Different legal choices for a command parameter are separated by character ‘|’. For instance, 

<variable> | <number> means that either variable or number can be used as parameters. 

• Items that can be repeated 0, 1 or more times are preceded by ‘{‘ and followed by ‘}*’. For 

instance {<number>}* means zero, one or more occurrences of a number.  

Syntax rules 

The following general syntax rules apply to VTP language files: 

• The VTP is a text-based, interpreted language 

• Commands, variables, and constant names are not case-sensitive. 

• All text at the right of a semicolon (‘;’) is treated as comment. 

• All strings are delimited by quotation marks (“a string”). Quote and backslash characters must 

be prefixed by the backslash symbols (“ a quote \” and a backslash \\”). 

• Filenames cannot contain pathnames. 
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Commands 

Scaling commands 

All drawing commands using coordinates can refer either to absolute or scaled coordinates. The 

absolute coordinate system starts at 0 and its measurement unit is the pixel (vertically the line). It 

extends up to the maximum drawing resolution in use minus one, expressed in pixels too. 

Conversely, the scaled coordinate system ranges from 0 to 10000, independently from the drawing 

resolution. Its measurement unit is thus a flexible, virtual pixel. 

Absolute coordinates provide the fastest drawing speed, but they are resolution specific. Scaled 

coordinates are resolution independent while introducing a slight speed penalization. 

For both systems, the origin (0,0) refers to the upper left hand corner of the screen. 

ABSOLUTE 

Syntax: ABSOLUTE 

This command is normally used in the beginning of the VTP file. All drawing commands issued after 

ABSOLUTE will have absolute coordinate values, i.e., their coordinates will be interpreted as pixels 

and lines.  

The allowed coordinate values are from 0 to the maximum drawing resolution minus one. For 

instance, for a drawing resolution of 2560 x 1600 pixels, the allowed coordinate range (x,y) for x is 0 

to 2559 and for y 0 to 1599. 

Constants MAXX and MAXY can be used in place of the numeric values to achieve basic scaling 

capabilities.  

SCALED 

Syntax: SCALED 

All drawing commands issued after the SCALED command will have their coordinates interpreted as 

within a range from 0 to 10000 (10001 possible coordinate values), regardless of the current drawing 

resolution. Positioning can be calculated as percentages. If you wanted to address a point at 50% of 

the drawing resolution, then you would use the number 5000. If you wanted 75% you would simply 

use the 7500. 

Graphics Drawing Commands 

All of the following graphics drawing commands use the currently selected foreground color for shape 

perimeter and filling. 

LINE 

Syntax: LINE x1 y1 x2 y2 

Draws a line from point (x1,y1) to point (x2,y2). 

Example: 

You can draw a white diagonal cross using either ABSOLUTE and SCALED coordinate mode and get 

the same result. 

ABSOLUTE ; Set scaling mode to absolute 

COLORDEPTH 8 ; 8 bits per color 

COLORRGB 255 255 255 ; white 

LINE 0 0 MAXX MAXY ; Draw a line from upper left to lower right corner 

LINE 0 MAXY MAXX 0 ; Draw a line from lower left to upper right corner  

Or if you want a fixed size for 640 x 480 resolution 

LINE 0 0 639 479 

LINE 0 479 639 0 
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The pattern will look like this: 

Using SCALED instead of ABSOLUTE. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

LINE 0 0 10000 10000 

LINE 0 10000 10000 0 

BOX 

Syntax: BOX x1 y1 x2 y2 

Draws a filled rectangle with upper left corner (x1,y1) and lower right corner (x2,y2). 

Example: 

This code will create a full white screen with all resolutions. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

BOX 0 0 10000 10000 

DOT 

Syntax: DOT x y 

Draws a single dot at location (x,y). 

FILL 

Syntax FILL x y 

Initiates a flood fill (or seed fill) with foreground color starting from position (x,y).  

CIRCLE 

Syntax: CIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Please, note that when using SCALED 

coordinates radius r is expressed as a vertical measure. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

CIRCLE 5000 5000 50 

(0,0) (MAXX,0) 

(MAXX,MAXY) (0,MAXY) 
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The pattern will look like this:  

FCIRCLE 

Syntax: FCIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Filled with foreground color. Please, note that 

when using SCALED coordinates radius r is expressed as a vertical measure. 

The pattern will look like this: 

ELLIPSE 

Syntax: ELLIPSE x y hr vr 

Draws an ellipse with center point at (x,y), horizontal radius hr and vertical radius vr. 

You can use ELLIPSE instead of CIRCLE for example when the displayed pixel is not square for 

compensating the stretching. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

ELLIPSE 5000 5000 3000 4000 

The pattern will look like this: 
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Text Drawing Commands 

All of the following commands use the currently selected foreground color for the “foreground” pixels 

of the font and the currently selected background color for “background” pixels. 

TEXTPOS 

Syntax: TEXTPOS x y 

Sets the text drawing position to point (x,y).  

TEXT 

Syntax: TEXT <string> | <var> | <const> { <string> | <var> | <const> }* 

The command executes a CR and LF (carriage return and line feed) and then draws a text string 

<string>, a variable <var>, a constant <const> or a combination of them starting from the current text 

position.  

<string> parameter is a quoted sequence of characters. If the string contains a quote character (“) or 

a backslash character (\) then it must be preceded with a back slash character (\). 

<var> is a parameter variable (A – Z, MAXX, MAXY) defined by SET command. 

<const> one of the Timing Variables. Timing variables are defined by currently loaded timing 

parameters. Please refer to Chapter 3. 

Note: Please note that when using the timing parameters in a pattern the display will be redrawn every time 

the timing is changed. Normally the VTG does not have to redraw the picture when only e.g., the 

horizontal sync is changed, but if the HS variable is used in the pattern it needs to be updated to 

display the new value. 

Example: 

ABSOLUTE 

COLORDEPTH 8 

COLORRGB 255 255 255 

TEXTPOS 100 100 ; Text starting point 100 pixels from left edge and 100 display lines 

down from top 

TEXT “HRES=” HR “ PIXELS ; This will draw the text HRES then the variable HR 

value and PIXELS 

TEXT “Quote character \” and backslash \\” 
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Program Flow Commands 

REPEAT 

Syntax: REPEAT <variable> a b s 

All commands after between REPEAT and END command are repeated the number of times defined 

by <variable>. <variable> is set to value a before starting the first iteration loop. At the end of each 

iteration, variable is incremented by s (variable = variable + s). The REPEAT is terminated when 

variable reaches or exceeds value b, and the execution continues from the command following the 

END command. For example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

REPEAT W 0 10000 200 

LINE W 0 W 10000 

END 

A maximum of 2 REPEAT loops can be nested (placed inside each other). 

END 

Syntax: END 

This command follows a REPEAT command and defines a group of instructions to be repeated. 

Color Commands 

The user can assign the used colors in two basic ways: either by giving the actual Red, Green and 

Blue (or R, G and B) color component values or using pre-defined color palettes. The first method is 

referred as True Color Mode and the latter as Palette Mode. 

In True Color Mode the numerical values given for R, G and B will be the actual output signal intensity 

values for the pixel in question. The numerical color value in Palette Mode will act as an address (or 

index) to a pre-defined color in a 256 color table. The output signal intensity will be the R, G and B 

value entry in the cell where the address points to. 

Palette mode can only be used with True Color Mode is . 

COLORDEPTH 

Syntax: COLORDEPTH n 

The command is used in True Color Mode (COLORMODE 2), to define the number of bits used for 

each color component (R, G and B) of the data to be displayed. Possible values for the parameter n 

are 6, 8, 10 and 12. If COLORDEPTH command is not used, 10 bits per color is used.  

Example: To display a bitmap that uses 8 bits for r, g and b (24-bit colors) you have to use 

COLORDEPTH 8.  

Command Nr of color bits Range of values for R, G and B 

COLORDEPTH 6 18 0 to 63 

COLORDEPTH 8 24 0 to 255 

COLORDEPTH 10 30 0 to 1023 

COLORDEPTH 12 36 0 to 4095 

 

COLORDEPTH can be used only once in a VTP file, and it has to be placed before all drawing 

instructions it is supposed to affect. 
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COLORRGB 

Syntax: COLORRGB r g b 

The command defines the foreground color used for the following drawing commands. The command 

is used in True Color Mode only. 

The range of values for r, g and b depends on the bits per color used. If not changed with 

COLORDEPTH command, 10 bits per color is used. Please refer to COLORDEPTH command for 

range of values. 

Various Commands 

SET 

Syntax: SET <variable> n 

Assigns value n to programming variable called variable. n must be a positive number or zero. 

 

Variables 

Timing Variables 

 

Timing Variable Value name 

HF  Drawing resolution horizontal size minus one 

HP  Drawing resolution vertical size minus one 

HR  Current timing horizontal frequency (MHz?) 

HA  Current timing horizontal period (pixels) 

HS  Current timing horizontal resolution (pixels) 

HBP  Current timing horizontal active time (pixels) 

HFP  Current timing horizontal sync length (pixels) 

VF  Current timing horizontal back porch length (pixels) 

VP  Current timing horizontal front porch length (pixels) 

VR  Current timing vertical frequency (MHz?) 

VA  Current timing vertical period (lines) 

VS  Current timing vertical resolution (lines) 

VBP  Current timing vertical active time (lines) 

VFP  Current timing vertical sync length (lines) 

PF  Current timing vertical back porch length (lines) 

HLB  Current timing vertical front porch length (lines) 

HRB  Pixel frequency (Mpps?) 

VTB Drawing resolution horizontal size minus one 

VBB  Drawing resolution vertical size minus one 
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Expressions 

Any command numeric parameter can be replaced by an expression, according to the syntax below: 

<term> ::= <variable> | <constant> | <number> 

<expression> ::= <term> { ‘+’ | ‘-‘ | ‘*’ | ‘/’ | ‘%’ }  <term> 

<parameter> ::= <term> | <expression> 

Some example of legal parameter values: 

B 

MAXX 

342 

B + MAXX 

B / 2 

B * C 

Expressions have always positive integers or zero value. When an expression evaluates to a negative 

value, it is set automatically to zero. Number values are also always positive integers or zero. 

Assignments 

A variable can be assigned a numerical value by using the SET command. 

The second parameter of the SET command can be replaced by an expression thus allowing 

commands like those here below: 

SET C B+MAXX 

SET K K+1 

SET K A+B 

Default state at VTP execution startup 

Coordinate system: ABSOLUTE 

Foreground color: 1023 1023 1023 

Background color: 0 0 0 

Output image is cleared (all black) 

All variables are initialized to zero 

COLORDEPTH 10 
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APPENDIX H: CREATING DSC CONTENT 
UCD-500 Pattern Generator function is able to source DSC content originating from pre-created DSC 

compressed files.  

Please find description of DSC Compressor tool under Pattern Generator earlier in this document. 

Please find below two alternative methods of creating DSC files. This description is divided in two 

parts. First part explains DSC conversion of a sample .ppm image and second part preparation and 

DSC conversion custom bitmap images. 

DSC Conversion Example 
Installation of UCD Console includes an option for installing also “DSC Content library” that is required 

e.g. for running DSC Compliance Test using UCD-500. Along with this library the installer includes an 

example for easily creating a DSC compressed sample bitstream file. 

The example can be found by default in folder 

C:\ProgramData\Unigraf\DSC_content_library\data\dsc-example 

In the example, the DSC conversion is done using batch file test.bat. It is creating DSC content from 

unigraf_default_image_8k.ppm using VESA created tool dsc.exe and its parameter file test.cfg.  

A detailed explanation of the process can be found later in this appendix in chapter DSC Conversion. 

In the example DSC conversion is done with the following main parameters: 

• Input file in test list.txt: unigraf_default_image_8k.ppm 

• Resolution: 7680 x 4320 pixels 

• One slice per line, slice height 108 lines 

• Pixel format RGB 4:4:4 

• Using predefined configuration file rc_16bpc_8bpp.cfg 

 To run the conversion double click test.bat  
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Creating Custom DSC Content 
Please find below instructions for creating DSC bitstream content from user selected bitmap files. 

Installation of the Tools 

 Download and install Unigraf Console. 

 Download and install ImageMagick from the authoritative web site 

https://imagemagick.org/script/download.php 

Please download for example the following version for Windows use: 

ImageMagick-7.1.0-28-Q16-x64-static.exe Win64 static at 16 bits-per-pixel component 

 Create a temporary folder in your PC and copy there the following items.  

• Files ffmpeg.exe and magick.exe in the folder where ImageMagick was installed. 

• Dsc.exe is installed with Unigraf Console. By default, the location is  

C:\Program Files\Unigraf\Unigraf UCD Tools 

• Batch file test.bat is installed with Unigraf Console. By default, the location is 

C:\Program Files\Unigraf\Unigraf UCD Tools\data\dsc-example 

• File test_list.txt is installed with Unigraf Console. By default, the location is 

C:\Program Files\Unigraf\Unigraf UCD Tools\data\dsc-example 

• File test.cfg is installed with Unigraf Console. By default, the location is 

C:\Program Files\Unigraf\Unigraf UCD Tools\data\dsc-example 

• Sample content can be found by default in self extracting compressed file 

C:\Program Files\Unigraf\Unigraf UCD Tools\data\dsc-images\dsc_sample_images_v2.exe 

Please extract the content in a folder in the temporary folder 

• Configuration files can be found by default in folder 

C:\Program Files\Unigraf\Unigraf UCD Tools\data\dsc 

Create a folder ConfigurationFiles in the temporary folder and copy there the needed files 

Preparation of  RGB 4:4:4 Images 

Please use the following command line instructions for preparing any bitmap file for DSC conversion. 

This chapter describes the tool for creating images with RGB 4:4:4 format. 

When using Linux: 

convert ./input_image -crop resolution+0+0 +repage -size resolution -

depth bpc -sampling-factor 4:4:4 ./output_image.ppm 

When using Windows: 

magick.exe convert ./input_image -crop resolution+0+0 +repage -size 

resolution -depth bpc -sampling-factor 4:4:4 ./output_image.ppm 

Parameters: 

input_image = image to prepare; bpc = 8, 10, 12; resolution = e.g. 3840x2160;  

output_image = prepared image 

Examples 

The following examples will use unigraf_default_image_16k.ppm as the test bitmap 

convert ./unigraf_default_image_16k.ppm -crop 3840x2160+0+0 +repage -size 

3840x2160 -depth 8 -sampling-factor 4:4:4 ./image-8bpc-RGB444.ppm 

convert ./unigraf_default_image_16k.ppm -crop 3840x2160+0+0 +repage -size 

3840x2160 -depth 10 -sampling-factor 4:4:4 ./image-10bpc-RGB444.ppm 

convert ./unigraf_default_image_16k.ppm -crop 3840x2160+0+0 +repage -size 

3840x2160 -depth 12 -sampling-factor 4:4:4 ./image-12bpc-RGB444.ppm 
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Preparation of  YUV Images 

ffmpeg -loglevel panic -i ./input_image -vf crop=resolution:0:0 -pix_fmt 

pixel_format ./output_image.yuv 

Parameters: 

-pix_fmt for 8bpc = yuv444p, yuv422p or yuv420p; 

-pix_fmt for 10bpc = yuv444p10le, yuv422p10le or yuv420p10le; 

-pix_fmt for 12bpc = yuv444p12le, yuv422p12le or yuv420p12le 

Examples 

ffmpeg -loglevel panic -i ./unigraf_default_image_16k.ppm -vf 

crop=3840:2160:0:0 -pix_fmt yuv422p ./image-8bpc-RGB422.yuv 

ffmpeg -loglevel panic -i ./unigraf_default_image_16k.ppm -vf 

crop=3840:2160:0:0 -pix_fmt yuv422p10le ./image-10bpc-RGB422.yuv 

ffmpeg -loglevel panic -i ./unigraf_default_image_16k.ppm -vf 

crop=3840:2160:0:0 -pix_fmt yuv422p12le ./image-12bpc-RGB422.yuv 

DSC Conversion 

The tool Dsc.exe will be used for creating the actual DSC compressed data.  

Dsc.exe is using configuration file test.cfg and test_list.txt as the list of images to process. 

Command syntax is 

dsc.exe -F test.cfg 

Test.cfg is a configuration file template. It should be edited to match the task. 

Example 

As an example of the conversion, please find below conversion a single file, image-12bpc-yuv420.yuv. 

 First step is the preparation of the image as explained above  

ffmpeg -loglevel panic -i ./unigraf_default_image_16k.ppm -vf 

crop=3840:2160:0:0 -pix_fmt yuv420p12le ./image-12bpc-RGB420.yuv 

 In the temporary folder, please create a file called test_list.txt and insert a line containing the 

name of the output file image-12bpc-RGB420.yuv. 

 After that we have to set appropriate parameters in the test.cfg configuration file. 

Set image resolution: 

PIC_WIDTH 3840 

PIC_HEIGHT 2160 

For selecting 4:2:0: 

USE_YUV_INPUT  1     // Enables YCbCr mode. Required to be =1 for 4:2:2 

           // and 4:2:0 modes. 

NATIVE_420     1     // Enables DSC 1.2 native 4:2:0 mode 

Indicate the corresponding configuration file file: 

INCLUDE    ./ConfigurationFiles/rc_12bpc_6bpp_420.cfg 

 Run the command 
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APPENDIX I: FIRMWARE RECOVERY 
The chapter below describes a procedure for recovering UCD-500 Series Firmware in a case when 

e.g., the normal FW Update procedure failed because a critical error.  

Downloading Tools 
The Recovery patch is programmed to UCD Device with a separate tool called  

Intel® Quartus® Prime Pro Edition Programmer and Tools. The tool can be downloaded from 

Intel® FPGA website: 

https://www.intel.com/content/www/us/en/software-kit/746667/intel-quartus-prime-pro-edition-

design-software-version-22-3-for-windows.html 

1. On the download page, please select section “Additional Software”. Please download the 

software under “Intel® Quartus® Prime Pro Edition Programmer and Tools”. 

2. Please download and install the tool using default option in the PC. 
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Step 1 
3. Connect the UCD device to the power supply and switch on power.  

4. Connect the UCD device with a USB cable to the PC through USB connector (Please refer to 

chapter Product Description > Connections earlier in this document) 

5. Please locate the UCD-500_recovery.zip file. Extract the content of the ZIP file in a folder in 

your PC, e.g., c:\Temp 

6. Open Windows Command Prompt application 

7. Change current directory to where the ZIP file was extracted (e.g. cd \Temp) 

8. Run batch file USB_backend_update.bat 

9. When instructed cycle power on the UCD device (switch off power > wait for 10 seconds > turn 

on power). 

Step 2 
1. Please make sure that power of the UCD device is switched on 

2. Connect a micro-USB cable to JTAG connector in the UCD device (Please refer to chapter 

Product Description > Connections earlier in this document). 

3. In the directory where the ZIP file was extrected (e.g. c:\Temp) edit file prog_sof.bat 

4. On line three (3) parameter “QUARTUS_DIR” is set to point to the folder where the Qartus 

Programmer was installed (by default C:\intelFPGA_pro\21.2). If needed, edit line three to 

match. Please save the file. 

5. In the same folder please note the name of the SOF file (e.g. s10_dptrx_F0.1.33_N2.3.15.sof) 

6. In Windows Command Prompt application please make sure that current directory is still the 

same (e.g. C:\temp) 

7. Launch batch prog_sof.bat <sof_file> where <sof_file> is the name of the SOF file noted 

earlier. 

8. Please wait until the batch file is completed (may take up to several minutes) 

Step 3 
Perform FW update procedure as described in section Installation > Firmware Update Procedure 

earlier in this manual. 

After Recovery procedure has been completed, you can delete the files stored in e.g., C:/Temp. 
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